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CHAPTER

1 ABOUT THIS GUIDE

Revision history

Revision Date Description

A November 2018 Initial release of this document

Intended audience

This documentation is intended for the following audience: Users who
plan, install, configure, operate, or maintain the ControlEdge™ 900
and 2020 controller and I\O modules running the eCLR (IEC 61131-
3) execution environment.

Prerequisite skills

Knowledge of SCADA systems and experience of working in a
Microsoft Windows environment are required.

Introduction to ControlEdge Technology

Item Description

ControlEdge
PLC

ControlEdge 900 controllers running the eCLR (IEC 61131-3) execution
environment with PLC software options configured with ControlEdge
Builder.

ControlEdge
RTU

ControlEdge 2020 controllers running the eCLR (IEC 61131-3)
execution environment with RTU software options configured with
ControlEdge Builder.

ControlEdge
UOC

ControlEdge 900 controllers running the Honeywell control execution
environment (CEE) configured with Experion Control Builder.

Special terms

The following table describes some commonly used industry-wide
and Honeywell-specific terminology:
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Terminology Description

CDA Control Data Access

ControlEdge 900
controller OPC UA

OPC UA runs on ControlEdge 900 controller

DNP3 Distributed Network Protocol V3.0

EFM Electronic Flow Measurement

Enron Modbus An extension of standard Modbus supports for 32-bit Integer
and Floating Point variables, and historical and flow data.

HART-IP HART-IP extends the HART protocol to Ethernet connected
nodes. This facilities host level systems and asset management
applications to access and integrate measurement and device
diagnostics information from HARTenabled field devices using
the existing plant networking infrastructure.

Modbus A communication protocol supports communication between
Modbus slave devices and Modbus master devices via serial port
or Ethernet port.

OPC Open Platform Communications

OPC UA OPC Unified Architecture

SCADA Supervisory Control and Data Acquisition

Related documents

The following list identifies publications that may contain information
relevant to the information in this document:

n Builder Software Installation User’s Guide

n ControlEdge Builder Software Change Notice

n ControlEdge PLC and ControlEdge RTU Getting started

n ControlEdge Builder User’s Guide

n ControlEdge 900 Platform Hardware Planning and Installation
Guide

n ControlEdge 2020 Platform Hardware Planning and Installation
Guide

n ControlEdge Builder Function and Function Block Configuration
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Reference Guide

n ControlEdge PLC and ControlEdge RTU Network and Security
Planning Guide

n ControlEdge EtherNet/IP User's Guide

n ControlEdge RTU DNP3 Device Profile
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CHAPTER

2 OVERVIEW

ControlEdge PLC and ControlEdge RTU supports various kinds of
protocol configuration. See the following table for details:

Protocol Description Supported by

DNP3 Slave See "DNP3 Slave Configuration" on page 17 for
more information.

ControlEdge
RTU

Modbus Slave See "Modbus Slave Configuration" on page 29
for more information.

ControlEdge
PLC and
ControlEdge
RTU

HART-IP Sever See "HART Configuration" on page 13 for more
information.

ControlEdge
PLC and
ControlEdge
RTU

Enron Modbus Slave See "Enron Modbus Slave Configuration" on
page 27 for more information.

ControlEdge
RTU

Modbus Master See "Modbus Master Configuration" on page 31
for more information.

ControlEdge
PLC and
ControlEdge
RTU

OPC UA Client See "OPC UA Client" on page 94 for more
information.

ControlEdge
PLC

OPC UA Server See "OPC UA Server" on page 73 for more
information.

ControlEdge
PLC

CDA Responder See "Configuring CDA " on page 147 for more
information.

ControlEdge
PLC

User Defined
Protocol

See "User Defined Protocol" on page 155 for
more information.

ControlEdge
PLC and
ControlEdge
RTU

Wireless I/O See "Configuring Wireless I/O" in ControlEdge
Builder User Guide for more information.

ControlEdge
RTU

EtherNet/IP See EtherNet/IP User Guide for more ControlEdge
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Protocol Description Supported by

information. PLC

12

Chapter 2 - Overview



CHAPTER

3 HART CONFIGURATION

HART supports two functionalities.

n HART IP client (FDM) communication
n HART Function Block communication

The controller enables the HART IP client to exchange information
with HART field devices connected to the AI/AO channels in the
controller via a HART-IP Server. Multiple HART IP clients can be
served by the controller at the same time. When the HART IP client
builds a HART command request and sends it to the TCP/IP port of
the HART-IP server, the HART-IP server responds to the HART IP
client with information from the field device. Since it takes time for
the controller to communicate with the field devices through onboard
or remote I/O cards, a delayed response mechanism is implemented.
The TCP /IP port of the HART-IP server is user-configurable and the
default port number is 5094. The end user may change the port
number if firewall configuration is required.

The controller enables HART function blocks to access to the HART
field devices through HART-enabled AI/AO channels. Currently HART
command 3, command 48 and command X are implemented.

Configuring a HART IP Server
A new project is created and a controller is added to the project in
ControlEdge Builder. See "Creating a project" and "Connecting a
controller" in ControlEdge Builder User's Guide for more details.

To set a controller as the HART IP Server:

1. From the Home Page, click Configure Ethernet Ports and select
ETH1 or ETH2.

2. Under Network Setting, select Use the following IP address and enter
the details in the IP Address, Subnet Mask and Gateway fields.

3. Under Protocol Binding, select HART IP to bind HART IP to the
Ethernet port.

4. Click Save to save the configuration, and click Back to return to the
Home Page.
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5. Click Configure Protocols > HART IP Server, select the target Ethernet
port and configure the port number in the Port. The default value
is 5094.

6. From the Home Page, click Configure I/O, and configure the target
AI or AO channel. For more information, see "Configuring I/O
modules and channels" in the ControlEdge Builder User's Guide.

7. Select the Enable checkbox for HART, and click Save.
8. Click Connect from the Home Page to connect a controller. For the

user name and password, see "User Privileges" in ControlEdge
Builder User's Guide.

9. Click Download from the Home Page to load the configuration of
HART IP to the controller.

Configuring a HART Function Block
From R151, two sets of HART function blocks are provided, HART and
HART_V2. HART _V2 is recommended to be used.

After downloading the configuration, you need to program the HART
device for the project in IEC Programming Workspace.

To configure a HART function block:

1. From the IEC Programming Workspace, under the Project Tree
Window, right-click Logical POUs and select Insert > Program.

2. Enter the Name for the new POU, and select the desired
programming Language. For the following steps, FBD language is
used as an example.

3. Click OK to insert the new POU in the project tree.
4. Add a Task as follows:

a. Under Physical Hardware, right-click Task and select Insert >
Task.

b. Enter the Name and select the task type as CYCLIC, and click OK.
c. In the Task settings dialog, configure the corresponding

parameters.
d. Click OK.

5. Right-click the task you have inserted, and select Insert > Program
instance.

6. Enter a name in the Program instance field.
The program instance must not be named “RTU” or
“GlobalVariable”.
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7. Select the program you want to associate from the Program type
drop-down list.

8. Right-click Libraries and select Insert > Firmware Library, select
hart.fwl under the HART folder. Then click Include.

9. Under Logical POUs, double-click the code worksheet of the
program that you have inserted.

10. From the Edit Wizard, select hart from the Group list. There are
three function blocks available for HART programming: HART_
CMD3 and HART_CMD48 as well as HART_CMDx.

11. Drag the target function block into the workplace to display the
function block.
For more information about the function block, right-click it and
select Help on FB/FU to display the embedded help.

12. Double-click the pin-outs of the function block to assign variables.
The Variable Properties dialog appears.

13. Select the Name, Data Type and Usage from the list.

l For the parameter GEN_DEV_STATUS, you should select HAR_
GEN_DEV_STATUS from the Data Type list.

l For the parameter DEV_INFO, you should select HART_CMD48_
DEV_INFO from the Data Type list.

14. Assign Initial value and I/O address details.

l For the parameter IOM, enter the target module number in the
Initial Value field. For example, if the target module name is
"Expansion I/O 01", enter "01".

l For the parameter CHN, enter the target channel number in the
Initial Value field.

15. Click OK. The workplace will appear as shown below.

Chapter 3 - HART Configuration



16. Click Make from the toolbar to compile the programs.
17. Click Download from the toolbar to download the compiled

programs of HART to the controller.
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CHAPTER

4 DNP3 SLAVE CONFIGURATION

Configuring a DNP3 Slave
To set a controller as a DNP3 Slave:

1. From the Home Page, click Configure Ethernet Ports and select
ETH1 or ETH2.

2. Under Network Setting, select Use the following IP address and enter
the details in the IP Address, Subnet Mask and Gateway fields.

3. Under Protocol Binding, select DNP3 to bind DNP3 to the Ethernet
port.

4. Click Save to save the configuration, and click Back to return to the
Home Page.

5. Click Configure Protocols > DNP3 Slave, select the target Ethernet
port you want to bind.

6. In the Physical Layer tab, configure the TCP port number.
7. In the Data Link Layer tab, select or enter the Master Address and

Controller Outstation Address.
8. Select Enable Self Address for the controller to respond with its

unique individual address, if a message is sent with the “Self
Address”. If Enable Self Address is not selected, the controller will
ignore the message that is sent to the “Self Address”.

9. Select Never from the Data Link Confirmation drop-down list and
enter the value in Data Link Retries and Data Link Retry Timeout
under Data Link Settings. Maximum value for data link retries is
255 and maximum value for retry timeout is 3,600,000ms.

l Never is selected by default. It is not recommended to select
MultiFrag or Always options.

l If you select MultiFrag or Always, ensure that the Data Link Retries
and Data Link Retry Timeout are set.

10. In the Application Layer tab, if you select Enable Unsolicited
Responses, the controller sends event data to SCADA without any
request from SCADA. Unsolicited Response is an operation mode
in which the outstation spontaneously transmits a response
without a specific request for the data.
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Parameter Description

Send Null Unsolicited
Responses on
Reconnection

The DNP3 driver sends a null unsolicited
message upon reconnect once it is
selected.

Maximum Hold Delay
of
Class1/Class2/Class3

The maximum hold delay is the maximum
amount of time that the controller will
wait after an event occurs before sending
an unsolicited response. This setting
allows the controller to queue several
events before sending an unsolicited
response, improving bandwidth usage at
the expense of delayed communication.

Minimum value: 0 ms and maximum
value: 3,600,000ms.

Maximum Hold
Count of
Class1/Class2/Class3

The maximum hold count is the maximum
number of events that may be queued
before sending an unsolicited response.
This setting allows the controller to send
multiple events in a single message,
improving bandwidth usage at the
expense of delayed communication.

Unsolicited Response
Retries

Enter the number of times the DNP3
driver attempts to send the unsolicited
application fragment upon not receiving
confirmation.

The value can be 0 to 255.

Unsolicited Response
Retry Delay

Enter the time intervals between retry to
send the unsolicited response.

Delete the oldest
event when queue is
full

According to requirement, select Delete
the oldest event when queue is full or not.
If this option is checked, in case the
DNP3 event buffer is full, then any new
event overwrites the oldest event.

Validate Outstation
Address

Select this option, the controller only
accept data from some specific outstation
address.

Keepalive Interval Enter the interval that DNP slave station
sends response to master station to make

18
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Parameter Description

sure if the connection is normal.

Enable DNP3 Time
Synchronization

Enable time synchronization from the
DNP3 master.

DNP3 Time
Synchronization
Period

Select the time that the controller should
indicate to SCADA that the time
synchronization is required.

ATTENTION: If you select DNP3
Time Sync here, you cannot enable
Primary Server and Secondary
Server under Miscellaneous >
Configure Date/Time options at the
same time, or else you cannot
download your configuration.

Solicited response
confirmation timeout

Enter the time in milliseconds the DNP3
driver waits for confirmation for the sent
solicited application fragment.

Unsolicited response
confirmation timeout

Enter the time in milliseconds the DNP3
driver waits for confirmation for the sent
unsolicited application fragment.

Maximum value for timeout is
3600000ms.

Select before
operation timeout

Enter the time in milliseconds the DNP3
driver waits for SBO.

EFM Data Class Select the corresponding class for EFM
data to SCADA communication.

Set the time interval for getting the EFM
responses back to Experion from the
controller through the DNP3 virtual
terminal point.

There are three options defined by the
DNP3 master:

l Class 1

l Class 2

Chapter 4 - DNP3 Slave Configuration



Parameter Description

l Class 3

11. Click Mapping tab, and then select the required mapping table
from the Mapping drop-down list.
The same mapping table may be selected for use on multiple
ports. For example, this could be used when a SCADA system
communicates through 2 ports in a redundant arrangement.

12. In the Default Variation tab, configure the default variation for each
type of DNP3 point. Default variation defines the data format that
is used by the controller to send data to the DNP3 Master, when
the Master does not ask for a specific data variation.

Parameter Description

Binary
Input

Used to report the current value of a binary input
point with three options:

l Any variation

l Packed format

l Value with flags

Binary
Input
Event

Used to report events related to a binary input point
with four options:

l Any variation

l Value without time

l Value with absolute time

l Value with relative time

Double-
bit Binary
Input

Used to report the current value of a double-bit
binary input point with three options:

l Any variation

l Packed format

l Value with flags

Double-
bit Binary
Input
Event

Used to report events related to a double-bit binary
input point with four options:

l Any variation

20
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Parameter Description

l Value without time

l Value with absolute time

l Value with relative time

Binary
Output

Used to control or report the state of one or more
binary output points with three options:

l Any variation

l Packed format

l Status with flags

Binary
Output
Event

A Binary Output Event Object is an instance of a
report for an outstation’s corresponding Binary
Output Static object.

l Any variation

l Status without time

l Status with time

Binary
Output
Command
Event

A Binary Output Command Event object reports that
a command has been attempted on an outstation’s
corresponding binary output point.

l Any variation

l Status without time

l Status with time

Counter Used to report the current value of a counter point
with five options:

l Any variation

l 32-bit integer with flag

l 16-bit integer with flag

l 32-bit integer without flag

l 16-bit integer without flag

Frozen
Counter

Used to report the value of a counter point captured
at the instant when the count is frozen with seven
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Parameter Description

options:

l Any variation

l 32-bit integer with flag

l 16-bit integer with flag

l 32-bit integer with flag. time

l 16-bit integer with flag. time

l 32-bit integer without flag

l 16-bit integer without flag

Counter
Event

Used to report the value of a counter point after the
count has changed with five options:

l Any variation

l 32-bit integer with flag

l 16-bit integer with flag

l 32-bit integer with flag. time

l 16-bit integer with flag. time

Frozen
Counter
Event

Used to report, as an event, the value of a counter
point captured at the instant when the count is
frozen.

l Any variation

l 32-bit integer with flag

l 16-bit integer with flag

l 32-bit integer with flag. time

l 16-bit integer with flag. time

Analog
Input

Used to report the current value of an analog input
point with seven options:

l Any variation

l 32-bit integer with flag

l 16-bit integer with flag

22
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Parameter Description

l 32-bit integer without flag. time

l 16-bit integer without flag. time

l Single-precision float with flag

l Double-precision float with flag

Analog
Input
Event

Used to report events related to an analog input
point with nine options:

l Any variation

l 32-bit integer with time

l 16-bit integer with time

l 32-bit integer without time

l 16-bit integer without time

l Single-precision float with time

l Double-precision float with time

l Single-precision float without time

l Double-precision float without time

Analog
Input
Deadband

Used to set and report the deadband value of an
analog input point with four options:

l Any variation

l 16-bit integer

l 32-bit integer

l Single-precision float

Analog
Output
Status

Used to report the status of an analog output point
with seven options:

l Any variation

l 32-bit integer with flag

l 16-bit integer with flag

l Single-precision float with flag

l Double-precision float with flag
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Parameter Description

Analog
Output
Event

An Analog Output Event Object is an instance of a
report for an outstation’s corresponding Analog
Output Status object. There are nine options:

l Any variation

l 32-bit integer with time

l 16-bit integer with time

l 32-bit integer without time

l 16-bit integer without time

l Single-precision float with time

l Double-precision float with time

l Single-precision float without time

l Double-precision float without time

Analog
Output
Command
Event

An Analog Output Command Event object reports
that a command has been attempted on an
outstation’s corresponding Analog Output point.
There are nine options:

l Any variation

l 32-bit integer with time

l 16-bit integer with time

l 32-bit integer without time

l 16-bit integer without time

l Single-precision float with time

l Double-precision float with time

l Single-precision float without time

l Double-precision float without time

13. Select Flash or SD card from the drop-down list besides Save DNP3
Events to:.

l If you want to save DNP3 events to SD card, you must allocate
the space for DNP3 events first. See "Preparing SD Card" in
ControlEdge Builder User's Guide for the detailed configuration.

24
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l Up to 80000 DNP3 events can be saved to Flash.

l Up to 198500 DNP3 events can be saved to SD card.

14. Click Save.
15. Click Connect from the Home Page to connect a controller. For the

user name and password, see "User Privileges" in ControlEdge
Builder User's Guide.

16. Click Download from the Home Page to load the configuration of
the DNP3 Slave to the controller.

Chapter 4 - DNP3 Slave Configuration
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CHAPTER

5 ENRON MODBUS SLAVE CONFIGURATION

Configuring an Enron Modbus Slave
To set a controller as an Enron Modbus Slave:

1. From the Home Page, click Configure Ethernet Ports and select
ETH1 or ETH2.

2. Under Network Setting, select Use the following IP address and enter
the details in the IP Address, Subnet Mask and Gateway fields.

3. Under Protocol Binding, select Enron Modbus Slave to bind it to the
Ethernet port.

4. Click Save to save the configuration, and click Back to return to the
Home Page.

5. Click Configure Protocols > Enron Modbus Slave, select the target
Ethernet port you want to bind.

6. Select Slave ID.For Ethernet ports, the port number must be
configured.
The port configured for Enron Modbus Slave cannot be the same
port as that configured for Modbus Slave.

7. Click Save.
8. Click Connect from the Home Page to connect a controller. For the

user name and password, see "User Privileges" in ControlEdge
Builder User's Guide.

9. Click Download from the Home Page to load the configuration of
the Modbus Slave to the controller.
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CHAPTER

6 MODBUS SLAVE CONFIGURATION

Configuring a Modbus Slave
This section introduces how to set a controller as a Modbus TCP Slave
or Modbus Serial Slave.

1. From the Home Page, click Configure Ethernet Ports to select an
Ethernet port, or click Configure Serial Ports to select a serial port.

2. Configure corresponding parameters for the Ethernet or serial
port.

3. Under Protocol Binding:

l Select Modbus Slave for an Ethernet port.

l Select Modbus RTU Slave or Modbus ASCII Slave for a serial port.

4. Click Save to save the configuration, and click Back to return to the
Home Page.

5. Click Configure Protocols > Modbus Slave, select the target Ethernet
or serial port you want to bind.

6. Select Slave ID.

7. For Ethernet ports, configure the TCP port number.

8. Select the required mapping table from the Mapping drop-down
list.
If the list is empty, you should add a mapping table first. See
"Adding a Modbus Slave mapping table" in the ControlEdge
Builder User's Guide.
The same mapping table may be selected for use on multiple
ports. For example, this could be used when a SCADA system
communicates through 2 ports in for redundancy.

9. For Ethernet port, select TCP or UDP from drop-down list of Type.

10. Click Save.

11. Click Connect from the Home Page to connect a controller. For the
user name and password, see "User Privileges" in ControlEdge
Builder User's Guide.
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12. Click Download from the Home Page to load the configuration of
the Modbus Slave to the controller.
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CHAPTER

7 MODBUS MASTER CONFIGURATION

Modbus TCP Master

Configuring a Modbus TCP Master
Modbus TCP Master is used for communication between the
controller and third-party Modbus slave devices over Ethernet.

A new project should be created and a controller should be added to
the project opened in ControlEdge Builder. See "Creating a project"
and "Connecting a controller" in ControlEdge Builder User's Guide for
more details.

To set a controller as a Modbus TCP Master:

1. From the Home Page, click Configure Ethernet Ports and select
ETH1 or ETH2.

2. Under Network Setting, select Use the following IP address and enter
the details in the IP Address, Subnet Mask and Gateway fields.

3. Under Protocol Binding, select Modbus TCP Master to bind Modbus
TCP Master to the Ethernet port.

4. Click Save to save the configuration, or click Back to return to the
Home Page.

5. Click Connect from the Home Page to connect a controller. For the
user name and password, see "User Privileges" in the ControlEdge
Builder User's Guide.

6. Click Download from the Home Page to load the configuration of
Modbus TCP Master to the controller.

Programming a Modbus TCP Master
After downloading the configuration, you need to program Modbus
TCP Master for the project in IEC Programming Workspace.

To program a Modbus TCP Master:

1. Right-click Logical POUs and select Insert > Program. Then enter the
name, and click OK. For the following steps, FBD language is used
as an example.
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2. Add a Taskas follows:

a. Under Physical Hardware, right-click Task and select Insert > Task.

b. In the pop-up window, enter the name. Select the task type as
CYCLIC, and click OK.

c. In the pop-up window of Task settings, configure the
corresponding parameters.

d. Click OK.

3. Right-click the task you have inserted, and selectInsert > Program
instance.

4. Enter a name in the Program instancefield.
The program instance must not be named “RTU” or
“GlobalVariable”.

5. Select the program you want to associate from the Program type
drop-down list.

6. Right-click Libraries and select Insert > Firmware Library, select
MODBUS.FWL. Then click Include.

7. Right-click Data Types and select Insert > Datatypes. In the pop-up
window, enter the Name and click OK.

8. Double-click the data type you have inserted and define an array in
worksheet shown as below as an example, then click Save button
from the toolbar. Click Make.

9. Under Logical POUs, double-click the code worksheet of the
program that you have inserted.

10. Drag the target function or function block of Modbus from the
Edit Wizard pane into the code worksheet, the function or function
block is displayed. There are twelve function blocks available for
Modbus master programming. See "Description of Modbus
Function Block" on page 39 for more information. For the
following steps, the function block MB_RD_MHR is used as an
example.

11. Double-click the pin-outs of the function or function block to
assign variables. In the pop-up Variable Properties window, select
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the Name, Data Type and Usage from the drop-down list, and assign
Initial value and I/O address. Then click OK. To assign initial values
to CONFIG_INFO:

To assign initial values to CONFIG_INFO:

CONFIG_INFO, a predefined data structure for Modbus
configuration information, is the crucial input for Modbus master
function blocks and contains key Modbus communication
parameters such as IP address of slave, slave ID, port number of the
controller to be used, etc. This data structure is read-only and
cannot be viewed and edited in ControlEdge Builder. See
"Description of CONFIG_INFO" on page 64 for more information.
Slave1 is the variable name assigned by the user of CONFIG_INFO.

12. Assign the data returned by the function block to variables to
monitor.

DATA1 is the variable name assigned by the user of OUTPUT pin of
MB_RD_MHR and it is an array.
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After the basic programming steps as described, the workplace will
appear as shown below.

13. Click Make from the toolbar to compile the programs.
14. Click Download from the toolbar to download the compiled

programs of Modbus TCP Master to the controller.

Modbus Serial Master

Configuring a Modbus Serial Master
Modbus Serial Master is used for communication between the
controller and third-party Modbus slave devices over a serial port.

A new project is created and a controller is added to the project
opened in RTU Builder. See "Creating a project" and "Connecting a
controller" in ControlEdge Builder User's Guide for more details.

To set the controller as a Modbus Serial Master

1. From the Home Page, click Configure Serial Ports and select the
target serial port to configure.

2. Under General,Port Name and Port Type are displayed automatically.
Select appropriate values for Baud Rate, Parity, Data Bits, Stop Bits,
Flow Control and Force Online if applicable. See the following tables
for parameter descriptions.

Parameter Description

Baud
Rate

300, 600, 1200, 2400, 4800, 9600, 19200, 38400,
57600, 115200

Table 7-1: Serial Port Parameters
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Parameter Description

RS232 does not support 57600 and 115200.

Parity None, ODD, EVEN

Data Bits 7, 8

Stop Bits 1, 2

For RS232-1 and RS232-2, there are two more options to
configure: Flow Control and Force Online. See the following table for
the parameter descriptions.

Parameter Description

Flow
Control

Only for RS232-1 and RS232-2

l None

l RTS-CTS

Force
Online

Only for RS232-1 and RS232-2.

Force Online is used to save energy when there is no
device connected to the controller RS232 ports by
disabling it.

Select the desired option from the Force Online drop-
down list:

l Disable

It is selected by default and the controller is on
power saving mode. RS232 transmitter will detect
the connection of external device. If external
device is connected to the controller, the local
transmitter will be enabled for communication. If
there is no external device connected, the local
transmitter will remain disabled to save energy.

l Enable

RS232 transmitter will not detect external device
and if you force enable, more energy is consumed.

Table 7-2: RS232 Serial Port Parameters
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The following table describes four scenarios that will happen for
Force Online option between the controller and the device it
communicates.

Controller
Force
Online
Option

Third-party
Device
Force
Online
Option

Communication

Enabled Enabled Normal

Disabled Enabled Normal, with energy saving on the
controller

Enabled Disabled Normal, with energy saving on Device

Disabled Disabled It is forbidden. Both devices would
consider there is no device connected to
it and hence there is no communication
between them.

Table 7-3: Force online scenarios between the controller and
devices

3. Under Protocol Binding, select Modbus RTU Master or Modbus ASCII
Master to bind Modbus Serial Master to the serial port. See the
following table for parameter descriptions.

Protocol Description

Modbus
RTU
Master

The controller acts as the Modbus Master and used for
communication between The controller and third-party
Modbus Slave devices, for example I/O modules.

Modbus
ASCII
Master

The controller acts as the Modbus Master and used for
communication between The controller and third-party
Modbus Slave devices, for example: I/O modules.

Table 7-4: Parameter descriptions of Modbus RTU Master and
Modbus ASCII Maste

4. Click Save to save the configuration, or click Back to return to the
Home Page.

5. Click Connect from the Home Page to connect a controller. For the
user name and password, see "User Privileges" in ControlEdge
Builder User's Guide.
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6. Click Download from the Home Page to load the configuration of
Modbus Serial Master to the controller.

Programming a Modbus Serial Master
After downloading the configuration, you must program Modbus
Serial Master for the project in IEC Programming Workspace.

To program a Modbus Serial Master:

1. Right-click Logical POUs and select Insert > Program. Then enter the
name, and click OK. For the following steps, FBD language is used
as an example.

2. Add a Task as follows:

a. Under Physical Hardware, right-click Task and select Insert >
Task.

b. In the pop-up window, enter the name. Select the task type as
CYCLIC, and click OK.

c. In the pop-up window of Task settings, configure the
corresponding parameters.

d. Click OK.
3. Right-click the task you have inserted, and select Insert > Program

instance.
4. Enter a name in the Program instance field.

The program instance must not be named “RTU” or
“GlobalVariable”.

5. Select the program you want to associate from the Program type
drop-down list.

6. Right-click Libraries and select Insert > Firmware Library, select
MODBUS.FWL. Then click Include.

7. Right-click Data Types and select Insert > Datatypes. In the pop-up
window, enter the Name and click OK.

8. Double-click the data type you have inserted and define an array in
worksheet shown as below as an example, then click Save from the
toolbar. Click Make.

Chapter 7 - Modbus Master Configuration



9. Under Logical POUs, double-click the code worksheet of the
program that you have inserted. The workspace appears.

10. Drag the target function or function block of modbus from the
Edit Wizard pane into the workspace, the function or function
block is displayed. There are twelve function blocks available for
Modbus master programming. See "Description of Modbus
Function Block" on the facing page for more information. For the
following steps, the function block MB_RD_MHR is taken as an
example.

11. Double-click the pin-outs of the function or function block to
assign variables. In the pop-up Variable Properties window, select
the Name, Data Type and Usage from the drop-down list, and assign
Initial value and I/O address. Then click OK.

To assign initial values to CONFIG_INFO:

CONFIG_INFO, a predefined data structure for Modbus
configuration information, is the crucial input for Modbus master
function blocks and contains key Modbus communication
parameters such as IP address of slave, slave ID, port number of the
controller to be used, etc. This data structure is read-only and
cannot be viewed and edited in RTU Builder. See "Description of
CONFIG_INFO" on page 64 for more information. Slave1 is the
variable name assigned by the user of CONFIG_INFO.
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12. Assign the data returned by the function block to variables to
monitor.

DATA1 is the variable name assigned by the user of OUTPUT pin of
MB_RD_MHR and it is an array.

After the basic programming steps as described, the workplace will
appear as shown below.

13. Click Make from the toolbar to compile the programs.
14. Click Download from the toolbar to download the compiled

programs of Modbus Serial Master to the controller.

Description of Modbus Function Block
With these function blocks, you can read and write single coil,
multiple coils, single discrete input, multiple discrete inputs, single
input register, multiple input registers, single holding register, etc., as
per Modbus protocol.
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Read Single Coil

Description

It is used to read a single coil.

Input

Parameter
Data
type

Description

ENABLE BOOL Enable: If TRUE, the FB is enabled and workable.

CONFIG_
INFO

User
defined
data
type

This is a structure provided by Honeywell. Modbus related
information is included. For more details, see Description_of_
CONFIG_INFO.htm.

START_
ADDR

UINT The first Modbus register address to read. Function code is not
included in the address.

SEND_
FLAG

BOOL If SEND_FLAG is true and RDY_FLAG is true, function blocks will
send the request. RDY_FLAG is TRUE means last communication
is finished. Before the last communication is finished, even if the
SEND_FLAG is true, the request won’t be sent.
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Output

Parameter
Data
type

Description

RDY_FLAG BOOL True: last communication is finished. FB is ready for the next
communication.

False: command request is being sent or received.

OUTPUT BOOL Output: 1: true, 0: OFF

DONE BOOL Indicates that the response is received from slave device.

ERR_FLG BOOL Will be set to TRUE if there is either a general error or a protocol
error.

PROTOCOL_
ERR

USINT Error numbers defined by Modbus protocol. See "Modbus
Protocol Error Codes" on page 67 for more information.

GEN_ERR USINT General error code:

0: Communication succeeded.

1: The input parameter is invalid.

2: Response timeout

3: Controller internal time out (IPC timeout).

4: Invalid request
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Read Multiple Coils

Description

It is used to read multiple coils.

Input

Parameter
Data
type

Description

ENABLE BOOL Enable: If TRUE, the FB is enabled and workable.

CONFIG_
INFO

User
defined
data
type

This is a structure provided by Honeywell. Modbus related
information is included. For more details, see Description_of_
CONFIG_INFO.htm.

START_
ADDR

UINT The first Modbus register address to read. Function code is not
included in the address.

LENGTH UINT The number of registers to read.

SEND_
FLAG

BOOL If SEND_FLAG is true and RDY_FLAG is true, function blocks will
send the request. RDY_FLAG is TRUE means the last
communication finished. Before the last communication is
finished, even if SEND_FLAG is true, the request won’t be sent.
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Output

Parameter
Data
type

Description

RDY_FLAG BOOL True: last communication is finished. FB is ready for the next
communication.

False: command request is being sent or received.

OUTPUT Array
of
BOOL

User defined data type: array of bool. The size of the array
should be equal to the number of the registers to read. Define a
data type as shown below:

TYPE
Variable Name: array[1..LENGTH] of

BOOL;
END_TYPE

DONE BOOL Indicates that the response is received from a slave device.

ERR_FLG BOOL Will be set to TRUE if there is either a general error or a protocol
error.

PROTOCOL_
ERR

USINT Error numbers defined by Modbus protocol. See "Modbus
Protocol Error Codes" on page 1 for more information.

GEN_ERR USINT General error code:

0: Communication succeeded.

1: The input parameter is invalid.

2: Response timeout

3: Controller internal time out (IPC timeout).

4: Invalid request
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Read Single Discrete Input

Description

It is used to read single discrete input.

Input

Parameter
Data
type

Description

ENABLE BOOL Enable: If TRUE, the FB is enabled and workable.

CONFIG_
INFO

User
defined
data
type

This is a structure provided by Honeywell. Modbus related
information is included. For more details, see Description_of_
CONFIG_INFO.htm.

START_
ADDR

UINT The first Modbus register address to read. Function code is not
included in the address.

SEND_
FLAG

BOOL If SEND_FLAG is true and RDY_FLAG is true, function blocks will
send the request. RDY_FLAG is TRUE means last communication
is finished. Before last communication is finished, even if SEND_
FLAG is true the request won’t be sent.
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Output

Parameter
Data
type

Description

RDY_FLAG BOOL True: last communication is finished. FB is ready for the next
communication.

False: command request is being sent or received.

OUTPUT Array
of
BOOL

User defined data type: array of BOOL. The size of the array
should be equal to the number of the registers to read.

OUTPUT BOOL Output: 1: true, 0: OFF

DONE BOOL Indicates that the response is received from a slave device.

ERR_FLG BOOL Will be set to TRUE if there is either a general error or a
protocol error.

PROTOCOL_
ERR

USINT Error numbers defined by Modbus protocol. See "Modbus
Protocol Error Codes" on page 1 for more information.

GEN_ERR USINT General error code:

0: Communication succeeded.

1: The input parameter is invalid.

2: Response timeout

3: Controller internal time out (IPC timeout).

4: Invalid request
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Read Multiple Discrete Inputs

Description

It is used to read multiple discrete inputs.

Input

Parameter
Data
type

Description

ENABLE BOOL Enable: If TRUE, the FB is enabled and workable.

CONFIG_
INFO

User
defined
data
type

This is a structure provided by Honeywell. Modbus related
information is included. For more details, see Description_of_
CONFIG_INFO.htm.

START_
ADDR

UINT The first Modbus register address to read. Function code is not
included in the address.

LENGTH UINT The number of registers to read.

SEND_
FLAG

BOOL If SEND_FLAG is true and RDY_FLAG is true, function blocks will
send the request. RDY_FLAG is TRUE means the last
communication is finished. Before the last communication is
finished, even if SEND_FLAG is true, the request won’t be sent.
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Output

Parameter
Data
type

Description

RDY_FLAG BOOL True: last communication is finished. FB is ready for the next
communication.

False: command request is being sent or received.

OUTPUT Array
of
BOOL

User defined data type: array of bool. The size of the array
should be equal to the number of the registers to read. Define a
data type as shown here:

TYPE
Variable Name: array[1..LENGTH] of

BOOL;
END_TYPE

DONE BOOL Indicates that the response is received from a slave device.

ERR_FLG BOOL Will be set to TRUE if there is either a general error or a protocol
error.

PROTOCOL_
ERR

USINT Error numbers defined by Modbus protocol. See "Modbus
Protocol Error Codes" on page 1 for more information.

GEN_ERR USINT General error code:

0: Communication succeeded.

1: The input parameter is invalid.

2: Response timeout

3: Controller internal time out (IPC timeout).

4: Invalid request
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Read Single Input Register

Description

It is used to read single input register.

Input

Parameter
Data
type

Description

ENABLE BOOL Enable: If TRUE, the FB is enabled and workable.

CONFIG_
INFO

User
defined
data
type

This is a structure provided by Honeywell. Modbus related
information is included. See "Description of CONFIG_INFO" on
page 64 for more information.

START_
ADDR

UINT The Modbus register address to read. Function code is not
included in the address.

SEND_
FLAG

BOOL If SEND_FLAG is true and RDY_FLAG is true, function blocks
would send the request. RDY_FLAG is TRUE means the last
communication is finished. Before last communication is
finished, even if SEND_FLAG is true, the request won’t be sent.
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Output

Parameter
Data
type

Description

RDY_FLAG BOOL True: last communication is finished. FB is ready for the next
communication.

False: command request is being sent or received.

OUTPUT BOOL 16bit Data read from the START_ADDR

DONE BOOL Indicates that the response is received from slave device.

ERR_FLG BOOL Will be set to TRUE if there is either a general error or a protocol
error.

PROTOCOL_
ERR

USINT Error numbers defined by Modbus protocol. See "Modbus
Protocol Error Codes" on page 1 for more information.

GEN_ERR USINT General error code:

0: Communication succeeded.

1: The input parameter is invalid.

2: Response timeout

3: Controller internal time out(IPC timeout).

4: Invalid request
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Read Multiple Input Registers

Description

It is used to read multiple input registers.

Input

Parameter
Data
type

Description

ENABLE BOOL Enable: If TRUE, the FB is enabled and workable.

CONFIG_
INFO

User
defined
data
type

This is a structure provided by Honeywell. Modbus related
information is included. For more details, see Description_of_
CONFIG_INFO.htm.

START_
ADDR

UINT The first Modbus register address to read. Function code is not
included in the address.

LENGTH UINT The number of registers to read.

SEND_
FLAG

BOOL If SEND_FLAG is true and RDY_FLAG is true, function blocks
would send the request. RDY_FLAG is TRUE means the last
communication is finished. Before the last communication is
finished, even if the SEND_FLAG is true, the request won’t be
sent.
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Output

Paramete
r

Data
type

Description

RDY_
FLAG

BOO
L

True: last communication is finished. FB is ready for the next
communication.

False: command request is being sent or received.

OUTPUT INT,
UINT,
DINT,
UDIN
T,
LINT,
REAL
or
LRE
AL;

User defined data type. The size of the array should be equal to the
number of the registers to read. The end user should define a data
type as shown here:

TYPE
array[1..LENGTH] of

INT/UINT/DINT/UDINT/LINT/REAL/LREAL;
END_TYPE

The end user can read the data of a specific register by using the
suffix.

ENDIAN_
MODE

USIN
T

Endian mode is required for reading/writing 32bit and 64 bit
variables. As Modbus always use big Endian to transceive data,
there is no need to set the Endian mode for 16-bit data.

1: little Endian mode for 32 bit data

2: byte-swapped little Endian mode for 32 bit data

3: big Endian mode for 32 bit data

4: byte-swapped big Endian mode for 32 bit data

5: little Endian mode for 64 bit data

6: byte-swapped little Endian mode for 64 bit data

7: big Endian mode for 64 bit data

8: byte-swapped big Endian mode for 64 bit data

Please see Endian_Mode.htm for details.

DONE BOO
L

Indicates that the response is received from slave device.

ERR_FLG BOO
L

Will be set to TRUE if there is either a general error or a protocol
error.
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Paramete
r

Data
type

Description

PROTOC
OL_ERR

USIN
T

Error numbers defined by Modbus protocol. See "Modbus Protocol
Error Codes" on page 1 for more information.

GEN_
ERR

USIN
T

General error code:

0: Communication succeeded.

1: The input parameter is invalid.

2: Response timeout

3: Controller internal time out (IPC timeout).

4: Invalid request

Read Single Holding Register

Description

It is used to read a single holding register.

Input

Parameter
Data
type

Description

ENABLE BOOL Enable: If TRUE, the FB is enabled and workable.
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Parameter
Data
type

Description

CONFIG_
INFO

User
defined
data
type

This is a structure provided by Honeywell. Modbus related
information is included. For more details, see Description_of_
CONFIG_INFO.htm.

START_
ADDR

UINT The Modbus register address to read. Function code is not
included in the address.

SEND_
FLAG

BOOL If SEND_FLAG is true and RDY_FLAG is true, function blocks
would send the request. RDY_FLAG is TRUE means the last
communication is finished. Before the last communication is
finished, even if the SEND_FLAG is true the request won’t be sent.

Output

Parameter
Data
type

Description

RDY_FLAG BOOL True: last communication is finished. FB is ready for the next
communication.

False: command request is being sent or received.

OUTPUT BOOL 16 bit data read from the START_ADDR

DONE BOOL Indicates that the response is received from slave device.

ERR_FLG BOOL Will be set true if there is either a general error or a protocol
error.

PROTOCOL_
ERR

USINT Error numbers defined by Modbus protocol. See "Modbus
Protocol Error Codes" on page 1 for more information.

GEN_ERR USINT General error code:

0: Communication succeeded.

1: The input parameter is invalid.

2: Response timeout

3: Controller internal time out (IPC timeout).

4: Invalid request
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Read Multiple Holding Registers

Description

It is used to read multiple holding registers.

Input

Parameter
Data
type

Description

ENABLE BOOL Enable: If TRUE, the FB is enabled and workable.

CONFIG_
INFO

User
defined
data
type

This is a structure provided by Honeywell. Modbus related
information is included. For more details, see Description_of_
CONFIG_INFO.htm.

START_
ADDR

UINT The first Modbus register address to read. Function code is not
included in the address.

LENGTH UINT The number of registers to read.

SEND_
FLAG

BOOL If SEND_FLAG is true and RDY_FLAG is true, function blocks
would send the request. RDY_FLAG is TRUE means the last
communication is finished. Before the last communication is
finished, even if the SEND_FLAG is true, the request won’t be
sent.
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Output

Parame
ter

Dat
a
type

Description

RDY_
FLAG

BO
OL

True: last communication is finished. FB is ready for the next
communication.

False: command request is being sent or received.

OUTPU
T

Arra
y of
INT,
UIN
T,
DIN
T,
UDI
NT,
LIN
T,
REA
L or
LRE
AL;

User defined data type. The size of the array should be equal to the
number of the registers to read. The end user should define a data type
as shown here:

TYPE
Variable Name: array[1..LENGTH] of

INT/UINT/DINT/UDINT/LINT/REAL/LREAL;
END_TYPE

The end user can read the data of a specific register by using the
suffix.

ENDIA
N_
MODE

USI
NT

Endian mode is required for reading/writing 32bit and 64 bit variables.
As Modbus always use big Endian to transceive data, there is no need
to set the Endian mode for 16-bit data.

1: little Endian mode for 32 bit data

2: byte-swapped little Endian mode for 32 bit data

3: big Endian mode for 32 bit data

4: byte-swapped big Endian mode for 32 bit data

5: little Endian mode for 64 bit data

6: byte-swapped little Endian mode for 64 bit data

7: big Endian mode for 64 bit data

8: byte-swapped big Endian mode for 64 bit data

Please see Endian_Mode.htm for details.
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Parame
ter

Dat
a
type

Description

DONE BO
OL

Indicates that the response is received from slave device.

ERR_
FLG

BO
OL

Will be set to TRUE if there is either a general error or a protocol error.

PROTO
COL_
ERR

USI
NT

Error numbers defined by Modbus protocol. See "Modbus Protocol
Error Codes" on page 1 for more information.

GEN_
ERR

USI
NT

General error code:

0: Communication succeeded.

1: The input parameter is invalid.

2: Response timeout

3: Controller internal time out (IPC timeout).

4: Invalid request

Write Single Coil

Description

It is used to write a single coil.
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Input

Parameter
Data
type

Description

ENABLE BOOL Enable: If TRUE, the FB is enabled and workable.

CONFIG_
INFO

User
defined
data
type

This is a structure provided by Honeywell. Modbus related
information is included. For more details, see Description_of_
CONFIG_INFO.htm.

START_
ADDR

UINT The Modbus register address to read. Function code is not
included in the address.

SEND_
FLAG

BOOL If SEND_FLAG is true and RDY_FLAG is true, function blocks
would send the request. RDY_FLAG is TRUE means the last
communication is finished. Before the last communication is
finished, even if the SEND_FLAG is true, the request won’t be
sent.

INPUT BOOL 1: ON

0: OFF

Output

Parameter
Data
type

Description

RDY_FLAG BOOL True: last communication is finished. FB is ready for the next
communication.

False: command request is being sent or received.

DONE BOOL Indicates that the response is received from slave device.

ERR_FLG BOOL Will be set to TRUE if there is either a general error or a protocol
error.

PROTOCOL_
ERR

USINT Error numbers defined by Modbus protocol. See "Modbus
Protocol Error Codes" on page 1 for more information.

GEN_ERR USINT General error code:

0: Communication succeeded.
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Parameter
Data
type

Description

1: The input parameter is invalid.

2: Response timeout

3: Controller internal time out (IPC timeout).

4: Invalid request

Write Single Holding Register

Description

It is used to write single holding register.

Input

Parameter
Data
type

Description

ENABLE BOOL Enable: If TRUE, the FB is enabled and workable.

CONFIG_
INFO

User
defined
data
type

This is a structure provided by Honeywell. Modbus related
information is included. For more details, see Description_of_
CONFIG_INFO.htm.

START_
ADDR

UINT The Modbus register address to read. Function code is not
included in the address.

SEND_
FLAG

BOOL If SEND_FLAG is true and RDY_FLAG is true, function blocks
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Parameter
Data
type

Description

would send the request. RDY_FLAG is TRUE means the last
communication is finished. Before the last communication is
finished, even if the SEND_FLAG is true, the request won’t be
sent.

INPUT UINT 16 bit input data of START_ADDR register

Output

Parameter
Data
type

Description

RDY_FLAG BOOL True: last communication is finished. FB is ready for the next
communication.

False: command request is being sent or received.

DONE BOOL Indicates that the response is received from slave device.

ERR_FLG BOOL Will be set to TRUE if there is either a general error or a protocol
error.

PROTOCOL_
ERR

USINT Error numbers defined by Modbus protocol. See "Modbus
Protocol Error Codes" on page 1 for more information.

GEN_ERR USINT General error code:

0: Communication succeeded.

1: The input parameter is invalid.

2: Response timeout

3: Controller internal time out (IPC timeout).

4: Invalid request
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Write Multiple Coils

Description

It is used to write multiple coils.

Input

Parameter
Data
type

Description

ENABLE BOOL Enable: If TRUE, the FB is enabled and workable.

CONFIG_
INFO

User
defined
data
type

This is a structure provided by Honeywell. Modbus related
information is included. For more details, see Description_of_
CONFIG_INFO.htm.

START_
ADDR

UINT The first Modbus register address to read. Function code is not
included in the address.

LENGTH UINT The number of registers to write.

SEND_
FLAG

BOOL If SEND_FLAG is TRUE and RDY_FLAG is true, function blocks
would send the request. RDY_FLAG is TRUE means the last
communication is finished. Before the last communication is
finished, even if the SEND_FLAG is true, the request won’t be
sent.

INPUT Array of
BOOL

User defined data type: array of bool. The size of the array should
be equal to the number of the registers to read. The end user
should define a data type as shown here:
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Parameter
Data
type

Description

TYPE
Variable Name: array[1..LENGTH] of BOOL;

END_TYPE

Use the suffix to set the status of a specific register.

Output

Parameter
Data
type

Description

RDY_FLAG BOOL True: last communication is finished. FB is ready for the next
communication.

False: command request is being sent or received.

DONE BOOL Indicates that the response is received from slave device.

ERR_FLG BOOL Will be set to TRUE if there is either a general error or a protocol
error.

PROTOCOL_
ERR

USINT Error numbers defined by Modbus protocol. See "Modbus
Protocol Error Codes" on page 1 for more information.

GEN_ERR USINT General error code:

0: Communication succeeded.

1: The input parameter is invalid.

2: Response timeout

3: Controller internal time out (IPC timeout).

4: Invalid request
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Write Multiple Holding Registers

Description

It is used to write multiple holding registers.

Input

Param
eter

Data
type

Description

ENAB
LE

BOO
L

Enable: If TRUE, the FB is enabled and workable.

CONFI
G_
INFO

User
defi
ned
data
type

This is a structure provided by Honeywell. Modbus related information
is included. For more details, see Description_of_CONFIG_INFO.htm.

STAR
T_
ADDR

UINT The first Modbus register address to read. Function code is not
included in the address.

LENG
TH

UINT The number of registers to write.

SEND_
FLAG

BOO
L

If SEND_FLAG is true and RDY_FLAG is true, function blocks would
send the request. RDY_FLAG is TRUE means the last communication is
finished. Before the last communication is finished, even if the SEND_
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Param
eter

Data
type

Description

FLAG is true, the request won’t be sent.

INPUT Array
of
INT,
UIN
T,
DIN
T,
UDI
NT,
LINT,
REA
L, or
LRE
AL

User defined data type. The size of the array depends on the number of
the registers to write:

Size of (array) * size of (element of array) / size of (UINT) = LENGTH.

The end user should define a data type as shown here:

TYPE
Variable Name: array[1..LENGTH] of

INT/UINT/DINT/UDINT/LINT/REAL/LREAL;
END_TYPE

Use the suffix to read the data of a specific register.

Output

Parameter
Data
type

Description

RDY_FLAG BOOL True: last communication is finished. FB is ready for the next
communication.

False: command request is being sent or received.

ENDIAN_
MODE

USINT Endian mode is required for reading/writing 32bit and 64 bit
variables. As Modbus always use big Endian to transceive data,
there is no need to set the Endian mode for 16-bit data.

1: little Endian mode for 32 bit data

2: byte-swapped little Endian mode for 32 bit data

3: big Endian mode for 32 bit data

4: byte-swapped big Endian mode for 32 bit data

5: little Endian mode for 64 bit data

6: byte-swapped little Endian mode for 64 bit data
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Parameter
Data
type

Description

7: big Endian mode for 64 bit data

8: byte-swapped big Endian mode for 64 bit data

Please see Endian_Mode.htm for details.

DONE BOOL Indicates that the response is received from slave device.

ERR_FLG BOOL Will be set to TRUE if there is either a general error or a protocol
error.

PROTOCOL_
ERR

USINT Error numbers defined by Modbus protocol. See "Modbus
Protocol Error Codes" on page 1 for more information.

GEN_ERR USINT General error code:

0: Communication succeeded.

1: The input parameter is invalid.

2: Response timeout

3: Controller internal time out (IPC timeout).

4: Invalid request

Description of CONFIG_INFO
The CONFIG_INFO pin defined in the function blocks is to input all the
configuration information for the Modbus master.

There are three types of communication between Modbus master and
Modbus slave: serial communication of ControlEdge 2020 controllers
using RS232 or RS485, Ethernet communication and serial
communication of ControlEdge 900 Controllers. Accordingly three
types of data structures are defined for CONFIG_INFO.

n For serial communication of ControlEdge 2020 controllers, the
data structure is defined as:

TYPE
MB_CONFIG_INFO_COM:
STRUCT

MB_SLAVE_ID: USINT;
PORT_NUM: USINT;
RETRIES: USINT;
TIMEOUT: UDINT;
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END_STRUCT;
END_TYPE

n For Ethernet communication, the data structure is defined as:

TYPE
MB_CONFIG_INFO_ETH:
STRUCT

MB_SLAVE_ID: USINT;
PORT_NUM: USINT;
RETRIES:

USINT;
TIMEOUT:

UDINT;
TCP_PORT_NUM: UINT;
IP_ADDR:

STRING;
END_STRUCT;

END_TYPE

n For serial communication of ControlEdge 900 Controllers, the
data structure is defined as:

TYPE
MB_CONFIG_INFO_ECOM:
STRUCT

MB_SLAVE_ID: USINT;
PORT_NUM: USINT;
RETRIES: USINT;
TIMEOUT: UDINT;
RACK_NUM: UDINT;
SLOT_NUM: UDINT;

END_STRUCT;
END_TYPE

See the following table for the parameter descriptions:

Parameter
Data
type

Description

MB_SLAVE_
ID

USINT Modbus slave ID: valid arrange: 1~247.

PORT_NUM USINT The physical interface of serial port:

1. RS232 port 1
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Parameter
Data
type

Description

2. RS232 port 2

3. RS485 port 1

4. RS485 port 2

5. reserved

6. reserved

The physical interface of Ethernet port:

1. Ethernet port 1

2. Ethernet port 2

3. reserved

4. reserved

RETRIES USINT Retry times before it is failed.

TIMEOUT UDINT Timeout unit: millisecond.

The minimal timeout is 500 ms. If the end-user gives a
number less than 500, the FB would send the default
timeout value instead.

TCP_PORT_
NUM

UINT TCP/IP port number of the Modbus slave device

IP_ADDR STRING The IP address of the Modbus slave device. Example:
‘192.168.0.100’

RACK_NUM UDINT The rack number of the serial port:

l 0 for local CPM,

l 1 to 99 for remote EPM

SLOT_NUM UDINT The slot number of the serial port, 1 to 12 are available

Description of Input and Output Data Type
Modbus supports reading and writing multiple consecutive registers.
In these cases, the input or output is defined as an array.

n For reading and writing coils and discrete inputs, array of BOOL is
defined.
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Set or retrieve the data value by using the suffix. For example: there
are 10 coils to read, the output array COIL_OUT can be defined as
array [1...10] of BOOL, reading the status of the fifth register could
be COIL_OUT [5].

n For reading and writing input registers and holding registers,
multiple array types can be defined: INT, UINT, DINT, UDINT, REAL,
LREAL or LINT.

Set or retrieve the data value by using the suffix. For example: there
are 3 LREAL variables , or in other words, 12 holding registers to
read, the output array LREAL_OUT can be defined as array[1..3] of
LREAL, reading the value of the second register could be LREAL_
OUT[2]. In this case, the Endian mode is involved.

Modbus Protocol Error Codes
Refer to the following table for Modbus Protocol Error Codes:

Error
Code

Item Description

0 success N/A

69 Connection broken Signals that the TCP/IP connection is closed by the
remote peer or broken.

129 checksum error N/A

130 invalid frame error Signals that a received frame does not correspond either
by structure or content to the specification or does not
match a previously sent query frame. A poor data link
typically causes this error.

131 Invalid reply error Signals that a received reply does not correspond to the
specification

132 reply timeout error Signals that a fieldbus data transfer timed out. This can
occur if the slave device does not reply in time or does not
reply at all. A wrong unit address will also cause this error.
On some occasions, this exception is also produced if the
characters received don't constitute a complete frame.

133 send timeout error Signals that a fieldbus data send timed out. This can only
occur if the handshake lines are not properly set.

161 illegal function
response

Signals that an illegal Function exception response was
received. This exception response is sent by a slave device
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Error
Code

Item Description

instead of a normal response message if a master sent a
Modbus function not supported by the slave device.

162 illegal address
response

Signals that an illegal Data Address exception response
was received. This exception response is sent by a slave
device instead of a normal response message if a master
queried an invalid or non-existing data address.

163 illegal value
response

Signals that an illegal Value exception response was
received. This exception response is sent by a slave device
instead of a normal response message if a master sent a
data value that is not an allowed value for the slave device.

164 failure response Signals that a Slave Device Failure exception response
(code 04) was received. This exception response is sent by
a slave device instead of a normal response message if an
unrecoverable error occurred while processing the
requested action. This response is also sent if the request
would generate a response whose size exceeds the
allowable data size.

Endian Mode
Modbus protocol supports 16bit data only. If there are 32bit or 64bit
variables, 2 or 4 consecutive registers should be used to read the data
value. In these cases, the Endian mode may be involved due to the
different Endian modes in Modbus slave devices.

See the following table for the concept of Endian modes used in
Modbus function blocks:

Endian mode Description

Little endian Lower registers contain lower bits and higher registers contain higher
bits. The order is on a register basis. Inside each register, the more
significant byte is always at the first place as defined by the Modbus
protocol.

Big endian Lower registers contain higher bits and higher registers contain lower
bits. The order is on a register basis. Inside each register, the more
significant byte is always at the first place as defined by the Modbus
protocol.

Byte-swapped The two bytes inside each register would be swapped.
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See the following table for the valid Endian modes:

Valid Endian mode Description

1 little Endian mode for 32 bit data

2 byte-swapped little Endian mode for 32 bit data

3 big Endian mode for 32 bit data

4 byte-swapped big Endian mode for 32 bit data

5 little Endian mode for 64 bit data

6 byte-swapped little Endian mode for 64 bit data

7 big Endian mode for 64 bit data

8 byte-swapped big Endian mode for 64 bit data
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CHAPTER

8 OPC UA CONFIGURATION

Introduction
OPC is the interoperability standard for the secure and reliable
exchange of data in the industrial automation space and in other
industries. It is a platform independent and ensures the seamless flow
of information among devices from multiple vendors.

OPC UA released in 2006 is a platform independent service-oriented
architecture that integrates all the functionality of the individual OPC
Classic specifications into one extensible framework.

ControlEdge 900 controller supports OPC UA server and client which
are built-in protocols in the controller, and it provides an IIoT-ready
open platform that enables users to better leverage data across their
assets. Benefits include:

n Smooth integration with a broad range of instruments, equipment
and software from multiple vendors

n Flexible and scalable design due to interoperable multi-level and
multi-platform open communication

n Direct access to cloud-based applications for visualization and
analytics

Prerequisite skills

This guidance uses terminology and concepts defined in OPC UA,
PLCOpen and IEC 61131-3 specifications. It is assumed that you have
familiarity with these Industry Standards. The following table lists
relevant OPC UA or PLCOpen terminology and concepts introduced
in this guide.

Reference Description

[UA-
3]

OPC Unified
Architecture
Specification
Part 3:
Address
Space Model,

Defines the basic address model concepts including nodes,
attributes, references, variables, data types and methods.
Standard node classes are defined in this specification.
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Reference Description

Release 1.03

[UA-
4]

OPC Unified
Architecture
Specification
Part 4:
Services,
Release 1.03

Abstract descriptions of OPC UA Services which are organized
into Service Sets. Familiarization with the “Overview” content
for the following Service Sets is recommended: SecureChannel,
Session, Monitored Item, and Subscription.

[UA-
5]

OPC Unified
Architecture
Specification
Part 5:
Information
Model,
Release 1.03

Building on the concepts introduced in Part 3, this
specification defines the UA Information model which is the
base for all OPC UA Information Models including PLCOpen. It
defines entry points into the address space, Server Object,
built-in object or data types, standard objects and their
variables and standard references.

[UA-
7]

OPC Unified
Architecture
Specification
Part 7:
Profiles,
Release 1.03

Defines meaningful collections of features for compliance
purposes. Familiarity with the terminology introduced in this
specification including profile, facet, and compliance unit is
recommended.

[DI] OPC Unified
Architecture
for Devices
Companion
Specification

Defines an OPC UA Information Model associated with
Devices. This information model provides a base for other OPC
UA companion specifications including PLC Open.

[PLC] PLCopen and
OPC
Foundation:
OPC UA
Information
Model for IEC
61131-3,
Release 1.00

Defines an OPC UA Information Model to represent the IEC
61131-3 architectural models. This specification is considered
a companion specification to the set of OPC UA specifications.
To understand the overall structure of the IEC 61131-3
Information model as it relates to DI and base OPC UA, see the
figure labeled as “OPC UA IEC 61131-3 ObjectTypes Overview”.

[IEC] IEC 61131
Basics

Help content that is accessible from ControlEdge Builder. IEC
61131 compliant PLC elements are described in detail
including those for data types.
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OPC UA Server
ControlEdge 900 controller OPC UA Server enables the native OPC
UA client access to information on ControlEdge 900 controller.

System Architecture and Profiles
The figure below conceptually shows the deployment of the
ControlEdge PLC OPC UA Server as an embedded OPC UA server. The
same is true for the OPC UA Client and Modbus Master that are also
shown in the figure below as examples of data sources. These
examples are in addition to the local or remote I/O capabilities of
ControlEdge 900 controller, all of which can be exposed by the
ControlEdge 900 controller OPC UA server when the data sources are
configured within the eCLR.

Although not shown below, it is possible to establish a peer to peer
connection from the embedded OPC UA Client to the embedded OPC
UA Server on a different ControlEdge 900 controller.
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The ControlEdge 900 controller OPC Server is based on the
Embedded UA Server profile defined in [OPC-7]. Refer to [PLC] for
additional companion specification profile information.

Access Level
Currently, the ControlEdge 900 controller OPC UA server allows both
read and write access of all exposed variables.

Security
Currently, the ControlEdge OPC UA Server is implemented with the
lowest security level.

Redundancy
The ControlEdge OPC UA Server does not support UA redundancy as
defined in [UA-4]. Furthermore, the ControlEdge OPC UA Server does
not maintain any state data. Therefore, if an unexpected disconnection
between the client and server occurs, it is the responsibility of the
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clients to re-establish connections (i.e. sessions). Even though none of
OPC UA redundancy profiles are supported, the Control Edge OPC UA
Server does participate in redundancy related usage scenarios
supported in ControlEdge 900 controller.

Accessing the Server Object
The ControlEdge 900 controller OPC UA Server supports the
standardized entry points into its address space.

n OPC UA clients can browse to the Server object by traversing the
hierarchy starting at Root.

n Alternatively, OPC UA clients can use the Server object’s well-
known node id to directly access its objects, properties and
variables.

Use the diagram legend to understand the objects, variables and
properties that the ControlEdge 900 controller OPC UA Server
supports.
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Server Diagnostics
The Sever Diagnostic object shown above, represents pertinent
diagnostic information related to the ControlEdge 900 controller OPC
UA server itself. All mandatory sub-components and properties are
supported [UA-5].

Accessing ControlEdge PLC data

Overview
DeviceSet is the entry point for OPC UA Clients that want to access
data from ControlEdge 900 controller. Shown below is an example
address space of the ControlEdge 900 controller OPC UA Server. It is
based on Object Types definitions found in the base UA specification
([UA-5]) as well as those definitions found in companion
specifications ([DI] and [PLC]). In this address space, there are three
example objects:

n eclrRes is an example of a Ctrl Resource

n SimpleUARead is an example of a Ctrl Program Instance.

n DftTask is an example of a Ctrl Task.

Figure 8-1: An example for address space of the ControlEdge 900
controller OPC UA Server
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Ctrl Resources
All the data on ControlEdge 900 controller is accessible by browsing
to the Object instance derived from CtrlResourceType. The
Browsename of this Object instance is the name given to the resource
that represents the controller itself.

Shown below is the output of a 3rd party client connected to the
ControlEdge 900 controller OPC UA Server. The objects listed below
PLC_Demo represents the complete set of data associated with
ControlEdge 900 controller including Programs, Tasks, Global
variables and Diagnostics.
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Ctrl Programs
In ControlEdge 900 controller, the instance of a POU assigned to a
task is treated as a program instance. Note that same program
instance in is able to be assigned to different task. They are treated as
different program instance.

Shown below is the output of a 3rd party client connected to the
ControlEdge 900 controller OPC UA Server, all Ctrl Program
instances executing in ControlEdge 900 controller are located under
Programs. For each Ctrl Program, the program variables and
Function Block instances including their child function blocks and
variables also appear in the address space.
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The “With” reference is used to show the association between the
program instance and the task that executes the program.

ControlEdge 900 controller Diagnostics
See "Overview" on page 76 for more information. OPC UA clients have
access to ControlEdge PLC diagnostic information exposed by the
GlobalVars and Diagnostics folder objects.

Located under the GlobalVars folder are the ControlEdge PLC System
Variables including PLC_SYS_TICK_CNT and PLC_MAX_ERRORS.

Located under the Diagnostics folder are the ControlEdge 900
controller diagnostics as viewed from the ControlEdge Configuration
Workspace of ControlEdge Builder.

Program Variable NodeIds
OPC UA Clients can use NodeIds to read, write and monitor variables
for data changes. The NodeIds for accessing IEC 61131-3 program
elements are defined with string identifiers. The string identifiers
embed the underlying name that the ControlEdge 900 controller OPC
UA Server uses to access the ControlEdge 900 controller variables.
See "Global and Diagnostic Variables" on the next page for more
information.
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See "Global and Diagnostic Variables" on the next page for more
information.

See "Program Variables" below for more information.

Global and Diagnostic Variables
For Global and Diagnostic variables, the Identifier element of the
NodeId is defined as: Identifier = @GV. <Varname>

For example, the NodeId of the global variable ‘PLC_SYS_TICK_CNT’ is
shown below.

Element NodeId

NamespaceIndex

IdentifierType String

Identifier @GV.PLC_SYS_TICK_CNT

TIP: For ControlEdge 900 controller OPC UA client, function
block “UaNamespaceGetIndex” is able to get the
NamespaceIndex when NamespaceUri of ControlEdge 900
controller OPC Server is available. See "Key Parameters to
establish OPC UA communication" on page 92 for more
information.

Program Variables
For Program local variables, the Identifier element of the Nodeid is
defined as:

Identifier = <Program Instance Name>.<Varname>

For example, the NodeId of the local variable ‘Connect’ defined within
the program instance ‘ReadWrite is shown below.

Element NodeId

NamespaceIndex

IdentifierType String

Identifier ReadWrite.Connect

For Function Block instance variables, the Identifier element of the
NodeId is define as:

Identifier = <Program Instance
Name>.<FunctionBlockInstance>.<Varname>
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The example below shows the NodeId of ‘ConnectHandle’ which is a
variable of the Function Block instance ‘UA_Read_Write_1’ in the
program ‘ReadWrite’

Element NodeId

NamespaceIndex

IdentifierType String

Identifier ReadWrite.UA_ReadWrite_1.ConnectionHandle

Data Types

Elementary types
The ControlEdge 900 controller OPC UA server maps all IEC 61131-3
elementary data types supported on the controller to an OPC UA built
in data type. The table below shows how the elementary data types
defined by IEC 61131 -3 map to OPC UA Built in data types.

IEC 61131-3 Elementary Data Types OPC UA Built In Data Types

BOOL Boolean

SINT SByte

USINT Byte

INT Int16

UINT UInt16

DINT Int32

UDINT Uint32

BYTE Byte

WORD UInt16

DWORD Uint32

REAL Float

LREAL Double

STRING String

TIME Double
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TIP: When writing to a variable, the ControlEdge OPC UA Server
shall return a Bad_TypeMismatch error if the data type of the
written value is not the same type or subtype of the variable’s
DataType.

Structured Types
The IEC 61131-3 STRUCT declaration represents a structured data
type as an aggregate data type. IEC 61131-3 structured data types
defined in ControlEdge 900 controller are mapped by the
ControlEdge OPC UA Server to OPC UA structured data types as
defined in [PLC] section 5.2.3.4. Shown below is the definition of
ANALOG_INPUT_TYPE as an IEC 61131-3 structured type defined in
ControlEdge 900 controller.

TYPE
ANALOG_INPUT_TYPE
STRUCT

STS : USINT;
PV : REAL;
EUHI : REAL;
EULO : REAL;
EUHIEX : REAL;
EULOEX : REAL;

END_STRUCT;
END_TYPE

To illustrate how the ControlEdge 900 controller OPC UA Server maps
ANALOG_INPUT_TYPE, we connect a 3rd party sample client to the
ControlEdge 900 controller OPC UA Server.

Shown below is the partial Browse output for a variable.
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Currently, the ControlEdge 900 controller OPC UA server implements
approach "c" as described in the section entitled “Many Variables and
/ or structured DataTypes” of [UA-3]. This means that an OPC UA
client can access the whole data structure as well as its individual
elements.

Shown below is the AddressSpace showing the variable, AIVar1 and
individual elements of the variable.

The following steps summarize how the ControlEdge 900 controller
OPC UA Server exposes IEC 61131-3 Structured Data Types such as
ANALOG_INPUT_TYPE to OPC UA Clients:

1. Creates an OPC UA Structured DataType with the same elements
as the IEC 61131-3 STRUCT.

2. Creates an OPC UA Complex Variable with the DataType created in
step 1.

3. Creates several simple Variables using simple DataTypes to reflect
the elements in the IEC 61131-3 STRUCT and exposes them as
variables of the Complex Variable created in step 2.

4. Adds the Variable created in step 2 to the AddressSpace to make
the data available to the OPC UA Client.
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Additionally, the Datatype, which in our example is ANALOG_INPUT_
TYPE, is added to the DataTypeDictionary. The DataTypeDictionary
also contains all the other structured DataTypes supported by the
ControlEdge 900 controller OPC UA Server.

Arrays
The ControlEdge 900 controller array data type is mapped to an OPC
UA data type derived from the corresponding elementary data type.
The ‘ValueRank’ attribute is used in UA to provide the information if a
value is an array and the ‘ArrayDimensions’ attribute provides the
length of each dimension. Arrays appear as a single node in the UA
address space.

Example of an array data type in ControlEdge 900 controller:

TYPE
UaLocaleIds : ARRAY [1..5] OF STRING;

END_TYPE

A variable, say ‘LocaleIds’, of this type in a 900 controller program will
be mapped to the OPC data type String with the ‘ValueRank’ attribute
set to 1 and ArrayDimensions[0] set to 5.

Arrays of Structured types
The ControlEdge 900 controller structured data arrays are modeled
along the lines of standard OPC UA array types such as
SubscriptionDiagnosticsArray defined in [UA-5]. Unlike an elementary
array that appears as a single node in the AddressSpace, the
structured data array will expose each entry of the array as a separate
node in the AddressSpace. This way a UA Client can access the entire
array, read an individual array entry or read individual elements of an
array entry.
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Shown below is an IEC 61131-3 array of struct ANALOG_INPUT_TYPE
defined in ControlEdge 900 controller.

TYPE
AIList : ARRAY [1..5] OF ANALOG_INPUT_TYPE;

END_TYPE

The program DftInst has a variable AIDataValues of type AIList. The
AddressSpace with the variable AIDataValues is shown below:

Object Types
OPC UA Clients can browse for Server specific function block types
from the CtrlTypes\FunctionBlocks Folder object as shown here:
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Reference types
The ControlEdge 900 controller OPC UA Server makes use of the
following Reference types defined in [PLC]:

n HasInputVar– used to reference variables declared with the key
word VAR_INPUT

n HasOutputVar– used to reference variables declared with the key
word VAR_OUTPUT

n HasInOutVar– used to reference variables declared with the key
word VAR_IN_OUT
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n HasLocalVar– used to reference variables declared with the key
word VAR

n With– used to reference the Ctrl Task that executes a Ctrl Program.

Configure ControlEdge 900 controller OPC UA Server

Configuration

Binding Protocol to Ethernet Ports

You must establish the physical address or endpoint that enables OPC
UA client access to the ControlEdge 900 controller OPC UA Server. A
maximum of two endpoints can be defined by binding the ETH1 or
ETH2 ports on ControlEdge 900 controller to OPC UA Server. One or
two endpoints are possible depending on if both ETH1 and ETH2 are
bound to OPC UA Server.

1. From the Home Page of ControlEdge Builder, click the arrow
beside Configure Ethernet Ports, and select ETH1 or ETH2.

2. Under Network Setting, select Use the following IP address and enter
the IP address of the Ethernet port.

3. Under Protocol Binding, select OPC UA Server.

4. Click Save to complete the configuration.

Configuring Parameters for OPC UA Server

The ControlEdge 900 controller OPC UA Server supports the UA TCP
transport protocol which defaults to communicate on TCP port 4840.
This communication port as well as other connectivity and tuning
parameters are available for optional configuration. The ControlEdge
900 controller OPC UA server uses default values if no alternative
value has been configured. The default configuration is sufficient for
getting started with connectivity.
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ATTENTION: Make sure that the OPC UA client’s time is
synchronized to the controller’s time.

1. From the Home Page of ControlEdge Builder, click Configure
Protocols > OPC UA Server. The OPC UA Server page appears.

Figure 8-2: OPC UA Server configuration page

2. Configure the parameters if required. See the following table for
the parameter description.
It is recommended to use the default values for the parameters.

Parameter Description

Port The port that clients will use to connect. For
example: opc.tcp://192.168.0.15:4840

The default value is 4840.

Max Request Age The maximum age of a request (in
milliseconds) the server allows. Zero value is
defined as unlimited.

Table 8-1: OPC UA Server parameter description
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Parameter Description

The default value, which is 0, indicating that
the request age allowed is unlimited.

Max Session
Count

The maximum number of concurrent sessions
the server allows.

If you enter a value of 0, the number of
sessions allowed is unlimited.

The default value is 100.

Max Subscription
Per Session

The maximum number of subscriptions
allowed by the server for one session.

If you enter a value of 0, the number of
subscription allowed is unlimited.

Max Session Per
Client

The maximum number of concurrent sessions
the server allows per client.

The default value, which is 0, indicating that
the number of sessions allowed is unlimited.

Min Session
Timeout

The minimum timeout for a session (in
milliseconds).

If you enter a value of 0, the minimum timeout
is unlimited.

The default value is 10000.

Max Session
Timeout

The maximum timeout for a session (in
milliseconds).

If you enter a value of 0, the maximum timeout
is unlimited.

The default value is 3600000.

Max Browse
Continuation
Points

The maximum number of browse continuation
points managed by a session.

The default value is 0.

Max Browse
Results

The maximum number of browse results for
one browse operation.

The default value, which is 0, indicating that
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Parameter Description

the number of browse results is unlimited.

Max Nodes To
Browse

The maximum number of nodes to browse.

The default value, which is 0, indicating that
the number of nodes allowed is unlimited.

Min Publishing
Interval

The minimum cycle rate of the Subscription.

The default value is 50 milliseconds.

Max Publishing
Interval

The maximum cycle rate of the Subscription.

The default value, which is 0, indicating that
the publishing interval allowed is unlimited.

Min Keep Alive
Interval

The minimum interval after which the
subscription sends a notification to the client.
This notification ensures the subscription is
maintained.

The default value is 5000 milliseconds.

Min Subscription
Lifetime

Provides assurance to the client that the
server is still alive.

The minimum period after which the
subscription will be deleted if no publish
request is received.

If you enter a value of 0, the subscription
lifetime allowed is unlimited.

The default value is 10000 milliseconds.

Max Subscription
Lifetime

Provides assurance to the server that the
client is still alive.

The maximum period after which the
subscription will be deleted if no publish
request is received.

The default value, which is 0 milliseconds,
indicating that the subscription lifetime
allowed is unlimited.

Max
Retransmission
Queue Size

The maximum number of messages allowed
per Subscription in the republish queue.
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Parameter Description

The default value is 10.

Max
Notifications Per
Publish

The maximum number of notifications allowed
per Publish.

The default value, which is 0, indicating that
the number of notifications allowed is
unlimited.

Max Data Queue
Size

The maximum size of data monitored item
queues.

The default value is 100.

Max Event
Queue Size

The maximum size of event monitored item
queues.

The default value is 1000.

Max Subscription
Count

The maximum number of subscriptions that
can be created.

The default value, which is 0, indicating that
the number of subscriptions allowed is
unlimited.

Max Monitored
Item Count

The maximum number of items that can be
monitored.

The default value, which is 0, indicating that
the number of items allowed is unlimited.

Max Monitored
Item Per
Subscription
Count

The maximum number of items that can be
monitored for each subscription.

The default value, which is 0, indicating that
the number of items allowed is unlimited.

Max Monitored
Item Per Session
Count

The maximum number of items that can be
monitored for each session.

The default value, which is 0, indicating that
the number of items allowed is unlimited.

For more information about the parameter descriptions, see the
specification in the https://opcfoundation.org/.

3. Click Save to complete the configuration.
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Key Parameters to establish OPC UA communication
To establish the communication between OPC UA Sever and OPC UA
client, below key parameters of Server must be provided and be
required in the configuration in OPC UA side.

Server Endpoint URL

The URL of ControlEdge 900 controller OPC UA Server defined as
follows:

<ControlEdge PLC OPC Server URL>:= “opc.tcp://” <IP>”:”<Port>

“opc.tcp://” is the protocol string portion of the URL. This string is
constant since the protocol used by the ControlEdge 900 controller
OPC UA Server is TCP.

<IP> is the IP address of ETH1 or ETH2 on ControlEdge 900
controller.

<Port> is the port number for the transport protocol. Port number
4840 is the default for OPC UA.

In the following URL examples, the IP address of ETH1 port on
ControlEdge 900 controller is set to 192.168.1.10. The IP address of
ETH2 port on ControlEdge 900 controller is set to 192.168.2.10.

TIP: One or both URLs may exist depending on the port
configuration.

opc.tcp://192.168.1.10:4840

opc.tcp://192.168.2.10:4840

When both Ethernet ports are configured as shown in the example
above, the ControlEdge 900 controller OPC UA Server considers the
links to be redundant. In this case, the ControlEdge 900 controller
OPC Server is listening on both endpoints. When one link is lost,
clients can use the URL of the second link to connect to the Server. It
is worth noting that the ControlEdge 900 controller OPC UA Server
maintains the session created on the failed link until the session
timeout period expires after which the session will be deleted.

In the case of redundant ControlEdge 900 controller, the IP address
follows the primary controller. Therefore, if a switchover occurs, the
client reconnects to the ControlEdge 900 controller OPC UA Server
on the new primary with the same URL that was used to connect to
the server on the failed primary.
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Namespace

OPC UA uses namespaces to uniquely differentiate between the
names and IDs it defines and those defined by companion
specifications or the local server. The ObjectTypes defined in the UA
specification for IEC 61131-3 derive from the OPC UA Device
Integration Types which in turn derive from the OPC UA Core
ObjectTypes. Thus the ControlEdge 900 controller OPC UA Server
includes these 3 namespaces in addition to its own namespace. The
list of namespaces used in the Server is shown below:

Namespace
Index

Namespace Description

0 http://opcfoundation.org/UA/ Namespace for NodeIds and
BrowseNames defined in the
OPC UA specification.

1 URL:<IP Address>:
Honeywell:ControlEdgePLC:UAServer
where IP Address is the IP of the
Ethernet port that is bound to OPC UA
Server. If UA is enabled on both ETH1
and ETH2, then the IP of ETH1 is used
for IP Address.

Namespace index 1 is reserved
for the local server, for nodes
specific to the server like those
shown in section 4.1. Note that
this URI is also the ServerURI
(appears in index 0 of the
ServerArray property). It is also
the ApplicationURI in the
subjectAltName field of the
server’s certificate.

2 http://opcfoundation.org/UA/DI/ Namespace for NodeIds and
BrowseNames defined in [DI].

3 http://PLCopen.org/OpcUa/IEC61131-
3/

Namespace for NodeIds and
BrowseNames defined in [PLC].

5 URN: Honeywell:UA:ControlEdgePLC Namespace for NodeIds and
BrowseNames of nodes used to
access the underlying
ControlEdge PLC data.

The exception is when these
nodes provide a standard
Property in which case the
BrowseName shall have the
namespace of the standards
body, even though the NodeId
will use this namespace. For
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Namespace
Index

Namespace Description

example, the ParameterSet and
the GlobalVars object
components of eclrRes shown
in section 6.1 - the
BrowseName for ParameterSet
will use [DI] namespace and the
BrowseName for GlobalVars will
use the [PLC] namespace.

Namespace Uri is used for OPC
UA client to get the
NameSpaceIndex.

OPC UA Client

IEC 61131-3 OPC UA Function Blocks
The function blocks within the OPCUA library are the native IEC
61131-3 OPC UA Function blocks as defined in [PLC-C]. The figures
below illustrate the common interface of each function block
regardless of the task that it performs.
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The table below references the above figures to describe the behavior
of the IEC 61131-3 OPC UA Function Blocks.

Interface Behavior

Execute
Input

The Function Block command or task is initiated by a rising edge at the
Execute input. While the value of Execute is equal to TRUE, the Busy,
Done and Error outputs can be examined independently to determine
the status of the function block execution. Furthermore, the Busy, Done
and Error outputs are mutually exclusive, i.e. only one of these outputs
can be set at a given time.

<input
parameters>

Input parameters are read at the rising edge of Execute input. Inputs are
only read once. Therefore, in order for changes to input parameters to
take effect, the Execute input must be re-initiated.
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Interface Behavior

Busy
Output

The Busy output is an indication that the function block has not
completed. This output is set to TRUE at the rising edge of Execute. It is
reset when either Done or Error is set.

Done
Output

The Done output, when set, is the indication that the function block has
completed successfully. This output is used to trigger the next step in a
sequence of function blocks.

TIP: Once the Done output is TRUE, the Execute input must be
reset prior to re-trigger of UaConnect function block.

Error
Output

If an error occurs during the execution of the function block, this output
is set. The ErrorID output contains the error number. Refer to [] for the
list of error codes.

l Since the function block did not complete successfully, the Done
output remains reset.

l Timeout input indicates the maximum time for the Function Block
to complete. If the timeout value expires, then the Error output is
set.

<output
parameters

Output parameters may be invalid while Busy output is set. Monitor the
Done output to trigger valid usage of output parameters (see flowchart
diagram below)

IEC 61131-3 OPC UA function block usage

Use of IEC 61131-3 OPC UA function blocks in the OPCUA library
requires special handling of BUSY, DONE and ERROR output
parameters as shown in the diagram to the right. Failure to perform
the special handling of the corresponding output parameters will
result in unexpected program errors. Consider use of the OPC UA
Helper Function Blocks to facilitate implementation of the required
special handling. See next section for details.
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Usage Considerations
The following table outlines a typical usage scenario when combining
OPC UA function blocks. Use the table to map the program phase
tasks to function blocks from the OPCUA or Honeywell Helper
libraries. See See "Prepare Phase for Reads, Writes or Method Calls"
on page 101 for more information. for more information.

Program
Phase

Task OPC UA Library Honeywell Helper Library

Prepare Establish
connection to
UA Server

UaConnect HonUaConnectSecurityNone
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Program
Phase

Task OPC UA Library Honeywell Helper Library

Get the
namespace-
index of a
namespace-URI
for the variables
in the target OPC
UA server’s
address space to
be read or written

UaNamespaceGetIndex
(translatepath)

See note1

Get the node
handle for the
variables in the
target OPC UA
servers address
space to be read
or written

UaNodeGetHandle

UaNodeGetHandleList

See note2

Get the method
handle for a
method call

UaMethodGetHandle See note3

Translate Path -
Get node
parameters using
path of the node.

UaTranslatePath

UaTranslatePathList

UaTranslatePaths

HonUaTranslatePathList

Create a
subscription

UaSubscriptionCreate See note 4

Work Reading of
variables in the
namespace of
UA Server

UaRead

UaReadList

HonUaReadNode

HonUaReadNodeList

Writing of
variables in the
namespace of
UA server

UaWrite

UaWriteList

HonUaWriteNode

HonUaWriteNodeList

Execution of
methods
supported by UA
Server

UaMethodCall HonUaCallMethod
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Program
Phase

Task OPC UA Library Honeywell Helper Library

Use a
subscription to
monitor variables

UaMonitoredItemAdd

UaSubscriptionOperate

HonUaSubscribeNode

Cleanup Release node
handle

UaNodeReleaseHandle

UaNodeReleaseHandleList

See note5

Release the
method handle

UaMethodReleaseHandle

Remove
monitored
variables from a
subscription

UaMonitoredItemRemove See not 6

Release a
subscription

UaSubscriptionDelete

Terminate the
connection to
OPC UA Server

UaDisconnect HonUaConnectSecurityNone

Utilities Monitor Handle
to signal loss of
handle due to
ControlEdge
PLC reset.

See note7 HonUaHandleDetector

Utility block to
monitor and
signal a change
in state.

See note8 HonUaStateDetector

Converts a
variable with
variant data type
to string format.
This is useful for
debugging
purposes.

HonUaVariantToString

Note:

1. Currently, there is no Honeywell Helper Function Block for
UaNamespaceGetIndex. However, refer to the structured text code for
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Program
Phase

Task OPC UA Library Honeywell Helper Library

HonUaTranslatePathList for an example.

2. Currently, there are no stand-alone Honeywell Helper Function Blocks for
UaNodeGetHandle and UaNodeGetHandleList. HonUaReadNode and
HonUaWriteNode are designed to include UaNodeGetHandle.
HonUaReadNodeList and HonUaWriteNodeList are designed to include
UaNodeGetHandleList.

3. Currently, there is no stand-alone Honeywell Helper Function Block for
UaMethodGetHandle. This is included in HonUaCallMethod.

4. Currently there is no stand-alone Honeywell Helper Function Block for simply
creating a subscription.

5. Currently, there are no Honeywell Helper Function Blocks for
UaNodeReleaseHandle, UaNodeReleaseHandleList and
UaMethodReleaseHandle.

6. Currently, there are no Honeywell Helper Function Blocks for
UaMonitoredItemRemove and UaSubscriptionDelete.

7. There are no IEC 61131-3 OPC UA blocks defined for these funtions.

8. There are no IEC 61131-3 OPC UA blocks defined for these funtions.

There are several ways to facilitate development of a PLC program
with OPC UA function blocks:

n Understand the OPC UA Function Block state model (Execute-
Busy-Done).

n Connect a graphical OPC UA Client to the target OPC UA server
(see tip below). Browse the target server address space to become
familiar with OPC UA communication parameters including:

l Node Identifier

l Node Namespace Index and associated Namespace URI

l Node data type

l Method Node ID and Object Node ID

n Use the Honeywell Helper Function Blocks. These function blocks
are implemented with structured text. Each helper function block
can be used directly in the same way function blocks from OPCUA
Library are used. Alternatively, use the Honeywell Helper Function
Blocks as examples to create custom helper function blocks.
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TIP: Use a graphical OPC UA Client

Consider use of a graphical OPC UA Client to access attributes
of the target OPC UA server and the nodes within its address
space. The example below shows the Browse output from OPC
Foundation Sample Client for an individual node.

To determine the NodeId attributes (NamespaceIndex,
IdentifierType and Identifier), view the value to the right of the
NodeId object in the Browse output. In this example:
NamespaceIndex = 4
IdentifierType = String
Identifier = ReadWrite.LocaleIds

The following sections describe the detailed usage information to
perform work tasks such as UaRead, UaReadList, UaWrite, UaWriteList
or UaMethodCall. These sections follow the order of tasks introduced
in the table above (shown below graphically).

Prepare Phase for Reads, Writes or Method Calls
Establishing a connection to the target OPC UA server is the primary
objective of the Prepare Phase. OPC UA servers require a physical
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network location or endpoint URL for connectivity. The endpoint URL
for an OPC UA server consists of several parts: prefix, host and port.
“opc.tcp://” is an example of a valid prefix portion of the URL. It
identifies the endpoint as an OPC Server and the protocol. The host
portion is either a hostname or IP address. The port number is the
target port of the OPC UA Server, which may vary among OPC UA
Server providers. Consult with the target OPC UA Server
documentation to verify the endpoint URL.

A new session is established each time a connection is established.

Establishing Connection with HonUaConnectSecurityNone

This function block uses the UaConnect function block to establish an
OPC UA session to a remote OPC Server using a specified Server URL
and Session name. The security related fields of SessionConnectInfo
are set to values that indicate no use of security. If successfully
established, the named session will have a 30 seconds timeout.

Figure 8-3: HonUaConnectSecurityNone

VAR_INPUT

ServerEndpointURL STRING e.g.,
“opc.tcp://192.168.1.30:51210/UA/SampleServer”

SessionName STRING Each time Connect executes a new session is
created on the server. This name will be
associated with that session

VAR_OUTPUT

ConnectionHandle DWORD The handle associated with this connection. Handle is
valid until Disconnect is set.
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VAR_OUTPUT

Error BOOL If set, signals an error occurred when attempting to
connect

ErrorID DWORD Error ID if any, returned by the server

VAR_IN_OUT

Connect BOOL When set TRUE and if ConnectionHandle is zero, initiates a new
connection. Upon completion of 1 connection attempt
(successful or unsuccessful) will automatically reset to FALSE.

Disconnect BOOL Set to FALSE

Use the HonUaconnectSecurityNone function block as an example to
create a custom connect helper block if alternative values for non-
security related fields of SessionConnectInfo are required (such as
LocalIDs or SessionTimeout).

Accessing the Address Space of target OPC UA Server

The information that the target OPC UA Server makes available to
clients is referred to as its address space. The elements of the address
space are represented as a set of nodes. Refer to [OPC-3] to address
space concepts including nodes, node attributes and
interconnections. Using standard OPC UA notation, the diagram
below shows the set of nodes common to all OPC UA Servers. As
indicated by the diagram key, this set of nodes includes objects,
variables, and properties. The diagram also illustrates the
relationships between nodes. Use a graphical OPC UA client
connected to the target OPC UA Server to view the set of standard
nodes for the target OPC UA Server.
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Every OPC UA node, regardless of its node type (e.g. object, variable,
property, etc.) is represented by a node identifier, which consists of
the following:

Element Nodeld

NamespaceIndex 1

IdentifierType String

Identifier Instrument_01.Temp

OPC UA uses namespaces to uniquely differentiate between the
names and IDs it defines and those defined by OPC UA companion
specifications (e.g. FDI) or the target OPC UA server itself. In the
example NodeId shown above, the NamespaceIndex is 1 which is the
index reserved for the “local” server. NamespaceIndex 0 is reserved
for OPC Foundation. It is the index to NodeIds and BrowseNames
defined in the OPC UA specifications. Consult with the target OPC UA
Server documentation for a list of supported name spaces.
Alternatively, use a graphical OPC UA Client connected to your target
OPC Server, to browse to the NameSpaceArray property node (see
diagram above). This node contains the required information for the
registered Namespaces on the target OPC UA Server. Each index in
the array is associated with a Namespace URI. Use the Namespace
URI with UaGetNamespaceIndex function block to resolve each
Namespace index from your PLC program. Since a namespace index
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can change dynamically, best practice is to resolve the namespace
URI programmatically.

Prepare with base UA blocks Prepare with Honeywell Helper UA blocks

The input to UaNodeGetHandle (as
circled above) requires steps
external to PLC program to obtain
the nodeIDds within each registered
namespace of the target OPC UA
Server.

l Consult the target OPC UA
documentation

l Use graphical OPC UA client
to browse the address space

l Requires special handling to
ensure completion of base UA
block before passing input to
subsequent block.

l UaNodeGetHandlemaps target
OPC Server nodeId to a node
handle maintained by
ControlEdgePLC OPC UA
Client. Node handles must be
explicitly supplied to the base
read and write blocks.

The input to HonUaTranslatePathList (as circled
above) requires steps external to PLC program
to obtain starting NodeId and a list of relative
paths. This information is used by the target
OPC Server to obtain the nodeIds for variables
to read or write. HonUaTranslatePathList
optionally performs the dynamic resolution to a
given namespace index.See "Obtaining Nodelds
with HonUaTranslatePathList" below for more
information.

TIP: HonUaReadNode,
HonUaReadNodeList, HonUaWriteNode,
HonUaWriteNodeList and
HonUaSubscribeNode use NodeIds rather
than node handles as input. The mapping
to node handles is built in to these
Honeywell helper function blocks.

The input to UaConnect and HonUaConnectSecurityNone requires steps external to PLC
program to obtain the URL of the target OPC UA Server.

Obtaining Nodelds with HonUaTranslatePathList

HonUaTranslatePathList is a convenient way to get NodeIds within a
single namespace registered with the target OPC UA server. It uses
UaNamespaceGetIndex and UaTranslatePaths.
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This function block requires the nodeID as a starting point in the
address space of the target OPC UA server. HonUaTranslatePathList
optionally resolves the namespace index in relative paths. If the
substitution token ‘#’ is inserted into the relative paths in
RelativePathList then the block acquires the index of this Uri from
namespace table of the target server. It then substitutes that index at
each ‘#’.

For example, if a string in the RelativePathList is
"/#:Drum1001/#:LIX001/#:Output" and NameSpaceUri
"http://opcfoundation.org/sampleserver" is located at index 4 in the
namespace index table of the target server, then
HonUaTranslatePathList modifies the string to
"/4:Drum1001/4:LIX001/4:Output" prior to passing to the target
server for translation.

Figure 8-4: HonUaTranslatePathList

VAR_INPUT

ConnectionHandle DWORD Connection handle obtained from Connection
block (e.g., “Connect_SecurityNone” above)

NodeIdStartNode UaNodeID The RelativePathList is evaluated using this node
as a starting point.

RelativePathList String255List Relative paths to the target nodes using
NodeIdStartNode as a starting point. See above for
syntax.

NamespaceUri STRING Supplied if NamespaceIndex substitution is
desired in any Relative Path. Otherwise, may be set
to empty string.
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VAR_OUTPUT

Error BOOL If set, signals an error occurred when attempting to
translate paths

ErrorID DWORD Error ID if any, returned by the server

Done BOOL Flag indicating that the function block execution
has completed. This flag will be reset FALSE the
next time ExecuteTranslate is set TRUE.

NodeIdOutCount UINT Number of NodeIDs returned

NodeIdOutList UaNodeIDList Node IDs corresponding to the relative paths in
RelativePathList

NodeErrorIdList UaNodeIDList Error ID associated with translating the
corresponding relative path to a Node ID. Note that
ErrorID above will be set if any element of this list
has a status other than good.

VAR_IN_OUT

ExecuteTranslate BOOL When set TRUE, initiates the relative path to NodeID
translation. Upon completion of 1 such attempt (successful
or unsuccessful) will automatically reset to FALSE.

Work Phase - Read/Write/Method Call

Work Phase with base UA blocks Work Phase with Honeywell Helper UA blocks

Tip: Requires special
handling to ensure
completion of base
UA block before
passing input to
subsequent block

Chapter 8 - OPC UA Configuration



Work Phase with base UA blocks Work Phase with Honeywell Helper UA blocks

TIP: Node handle mapping is built-in
to HonUaRead, HonUaReadList,
HonUaWrite and HonUaWriteList

Reading a single variable

Figure 8-5: HonUaReadNode

VAR_INPUT

ConnectionHandle DWORD Connection handle obtained from Connection block
(e.g., “Connect_SecurityNone” above)

NodeIdRead UaNodeID Node ID whose data value is to be read.

IsArray BOOL Flag indicating whether or not the NodeIdRead data
value is an array.

ArrayIndex UINT If IsArray is TRUE then this identifies the array index to
read.

VAR_OUTPUT

DataStatus UDINT Status code associated with the DataValueOut

DataValueOut UAVariant Value of the node (attribute 13)

TimeStamp UADateTime Source timestamp associated with DataValueOut

ErrorID DWORD Error ID if any, returned by the server when attempting to
invoke the Read service.
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VAR_OUTPUT

Error BOOL If set, signals that an error occurred when attempting to
invoke the Read service .

ReadEnabled BOOL When set, indicates that block is enabled and read
service will be called with each task cycle.

VAR_IN_OUT

EnableRead BOOL When set TRUE, enables this read block. Read service will be
called with each task cycle. See ReadEnabled above to verify that
block is enabled.

DisableRead BOOL When set TRUE, disables this read block. Read service will not be
called with each task cycle. See ReadEnabled above to verify that
block is disabled.

Reading a list of variables

Figure 8-6: HonUaReadNodeList

VAR_INPUT

ConnectionHandle DWORD Connection handle obtained from Connection
block (e.g., “Connect_SecurityNone” above)

NodeIdCount UINT The number of Node IDs in NodeIdReadList

NodeIdReadList UaNodeIDList Node identifiers of the nodes whose values are to
be read by this block (max 20 identifiers).
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VAR_INPUT

IsArray BOOL Flag indicating whether or not the
NodeIdReadList data values are arrays

ArrayIndices UINTList If IsArray is TRUE then this identifies the array
index for each data value of NodeIdReadList to
read. NodeIdReadList and ArrayIndices must
contain the same number of elements.

VAR_OUTPUT

ErrorID DWORD Error ID if any, returned by the server when
attempting to invoke the Read service.

Error BOOL If set, signals that an error occurred when
attempting to invoke the Read service

ReadEnabled BOOL When set, indicates that block is enabled and the
Read service will be called with each task cycle.

DataStatusList UaDWORDList Status code associated with corresponding value
of the DataValueOutList

DataValueOutList UAVariantList Value of each node (attribute 13)

TimeStampList UaDateTimeList Source Timestamp associated with corresponding
value of the DataValueOutList

NodeErrorIdList UaDWORDList Error ID associated with corresponding value of
the DataValueOutList. Note that ErrorID above will
be set if any element of this list has a status other
than good.

VAR_IN_OUT

EnableReadList BOOL When set TRUE, enables this read block. Read service will be
called with each task cycle. See ReadEnabled above to verify
that block is enabled.

DisableReadList BOOL When set TRUE, disables this read block. Read service will
not be called with each task cycle. See ReadEnabled above
to verify that block is disabled.

Writing a single variable

Figure 8-7: HonUaWriteNode
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VAR_INPUT

ConnectionHandle DWORD Connection handle obtained from Connection block
(e.g., “Connect_SecurityNone” above)

NodeIdWrite UaNodeID Node ID whose data value is to be written.

IsArray BOOL Flag indicating whether or not the NodeIdWrite data
value is an array

ArrayIndex UINT If IsArray is TRUE then this identifies the array index to
write.

DataValue UAVariant Value to be written (attribute 13)

VAR_OUTPUT

ErrorID DWORD Error ID if any, returned by the server when attempting to
invoke the Write service.

Error BOOL If set, signals that an error occurred when attempting to
invoke the Write service

WriteEnabled BOOL When set, indicates that block is enabled and write service will
be called with each task cycle.

VAR_IN_OUT

EnableWrite BOOL When set TRUE, enables this write block. Write service will be
called with each task cycle. See WriteEnabled above to verify that
block is enabled.

DisableWrite BOOL When set TRUE, disables this write block. Write service will not be
called with each task cycle. See WriteEnabled above to verify that
block is disabled.
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Writing a list of variables

Figure 8-8: HonUaWriteNodeList

VAR_INPUT

ConnectionHandle DWORD Connection handle obtained from Connection
block (e.g., “Connect_SecurityNone” above)

NodeIdCount UINT The number of Node IDs in NodeIdWriteList

NodeIdWriteList UaNodeIDList Node identifiers of the nodes whose values are to
be written by this block (max 20 identifiers).

IsArray BOOL Flag indicating whether or not the
NodeIdWriteList data values are arrays

ArrayIndices UINTList If IsArray is TRUE then this identifies the array
index for each data value of NodeIdWriteList to
read.

NodeIdWriteList and ArrayIndices must contain
the same number of elements.

DataValueList UAVariantList Values to be written (attribute 13).

VAR_OUTPUT

ErrorID DWORD Error ID if any, returned by the server when
attempting to invoke the Write service.

Error BOOL If set, signals that an error occurred when attempting
to invoke the Write service

WriteEnabled BOOL When set, indicates that block is enabled and the
Write service will be called with each task cycle.
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VAR_OUTPUT

NodeErrorIdList UaDWORDList Error ID associated with corresponding value of the
DataValueList when attempting to write the value.
Note that ErrorID above will be set if any element of
this list has a status other than good.

VAR_IN_OUT

EnableWriteList BOOL When set TRUE, enables this write block. Write service will be
called with each task cycle. See WriteEnabled above to verify
that block is enabled.

DisableWriteList BOOL When set TRUE, disables this write block. Write service will
not be called with each task cycle. See WriteEnabled above
to verify that block is disabled.

Calling a Method

Figure 8-9: HonUaCallMethod

VAR_INPUT

ConnectionHandle DWORD Connection handle obtained from Connection
block (e.g., “Connect_SecurityNone” above)

NodeIdentifierObject UaNodeID Node ID of the object node whose method is to
be called by this block

NodeIdentifierMethod UaNodeID Node ID of the method node to be called by
this block

InputArguments UAVariantList Input arguments for this method. Note that
some methods may not require any input
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VAR_INPUT

arguments.

Done BOOL Flag indicating that the method call has
completed. This flag will be reset FALSE the
next time ExecuteCall is set TRUE.

VAR_OUTPUT

ErrorID DWORD Error ID if any, returned by the server when
attempting to invoke the Call service.

Error BOOL If set, signals that an error occurred when
attempting to invoke the Call service

OutputArguments UAVariantList Output arguments returned by this method. Note
that some methods may not return output
arguments

InputArgResults UaDWORDList Status code associated with each argument in the
InputArguments.

VAR_IN_OUT

ExecuteCall BOOL When set TRUE, invokes the method call. Upon completion of 1
method call attempt (successful or unsuccessful) will
automatically reset to FALSE.
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Work Phase - Subscripbe for Variable Notifications

Work Phase with base UA blocks
Work Phase with Honeywell Helper UA
blocks

TIP: Requires special handling to
ensure completion of base UA
block before passing input to
subsequent block.

TIP: Node handle mapping is built-
in to HonUaSubscribeNode.
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Subscribing for single variable notifications

VAR_INPUT

ConnectionHandle DWORD Connection handle obtained from Connection block
(e.g., “Connect_SecurityNone” above)

NodeIdSubscribe UaNodeID The NodeId of the data variable node which will be
added as monitored item to the subscription.

IsArray BOOL Flag indicating whether or not the NodeIdSubscribe
data value is an array.

VAR_OUTPUT

ErrorID DWORD Error ID if any, returned by the
server when attempting to
invoke the subscription or
monitored item service.

Error BOOL If set, signals that an error
occurred when attempting to
invoke the subscription or
monitored item service.

SubscriptionEnabled BOOL A flag indicating that the
subscription is currently
enabled.

DataChangeNotification UaDataChangeNotification Notifications for the subscribed
node. A notification will occur
when the value or the status of
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VAR_OUTPUT

the variable changes.

VAR_IN_OUT

EnableSubscription BOOL Set the subscription enabled.

DisableSubscription BOOL Set the subscription disabled.

Cleanup Phase
Releasing resources that were previously acquired during the Prepare
and Work Phases is the primary objective of the Cleanup Phase.

Cleanup - Read/Write/Method Call;

Cleanup with base UA blocks Cleanup with Honeywell Helper UA blocks

Cleanup - Subscribe for Variable Notifications

Cleanup with base UA blocks Cleanup with Honeywell Helper UA blocks

Terminate Connection with HonUaConnectSecurityNone

This function block uses the UaDisconnect function block to
terminate an OPC UA session to a remote OPC Server using the
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ConnectionHandle.

Figure 8-10: Terminate Connection with HonUaConnectSecurityNone

VAR_INPUT

ServerEndpointURL String255 e.g.,
“opc.tcp://192.168.1.30:51210/UA/SampleServer”

SessionName STRING Each time Connect executes a new session is created
on the server. This name will be associated with that
session

VAR_OUTPUT

ConnectionHandle DWORD The handle associated with this connection. Handle is
valid until Disconnect is set.

Error BOOL If set, signals an error occurred when attempting to
connect

ErrorID DWORD Error ID if any, returned by the server

VAR_IN_OUT

Connect BOOL Set to FALSE

Disconnect BOOL When set TRUE initiates a disconnect of the current
ConnectionHandle (as indicated by ConnectionHandle). Upon
completion of 1 disconnect attempt (successful or unsuccessful)
will automatically reset to FALSE.

Utilities
In addition to the helper blocks described in the previous Prepare and
Work phase sections, the Honeywell OPC UA Helper Block library
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includes several utilities that are convenient for error detection, error
handling and debugging.

Monitoring the target OPC UA Server handle

HonUaHandleDetector prevents usage of an invalid Server handle to the
target OPC Server. Currently, a server handle is invalidated if
ControlEdge 900 controller resets. A future release of ControlEdge
900 controller will allow OPC UA server handles to ride through a
ControlEdge 900 controller reset.

Figure 8-11: HonUaHandleDetector

VAR_INPUT

Enable BOOL When set TRUE enables the block functionality. When set FALSE
disables the block functionality.

DWORDIn DWORD When Enable is set TRUE, the block will monitor DWORDIn for
change to 0. If this occurs then SignalOut is set TRUE.

VAR_OUTPUT

SignalOut BOOL See DWORDIn above

Detecting Boolean Resets

HonUaStateDetector is a convenient way to detect that a Boolean flag
has been reset from TRUE to FALSE.

Figure 8-12: HonUaStateDetector
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VAR_INPUT

Enable BOOL When set TRUE enables the block functionality. When set FALSE
disables the block functionality.

BOOLIn BOOL When Enable is set TRUE, the block will monitor BOOLIn for change
to FALSE. If this occurs then SignalOut will be set TRUE.

VAR_OUTPUT

SignalOut BOOL See BOOLIn above

Converting Variant Values to String

HonUaVariantToString is useful for debugging purposes. It converts the
fields of a variant to a single string.

Figure 8-13: HonUaVariantToString

VAR_INPUT

VariantIn UAVariant Variant value (i.e., as returned from FB “ReadNode”)

VAR_OUTPUT

StringOut STRING String representation of VariantIn

Configuring an OPC UA Client

Binding Protocol to Ethernet Ports

You must establish the physical address or endpoint that enables OPC
UA client access to the ControlEdge 900 controller OPC UA Server.

1. From the Home Page of ControlEdge Builder, click the arrow
beside Configure Ethernet Ports, and select ETH1 or ETH2.

2. Under Network Setting, select Use the following IP address and enter
the IP address of the Ethernet port.

120

Chapter 8 - OPC UA Configuration



121

3. Under Protocol Binding, select OPC UA Client.

4. Click Save to complete the configuration.

Configuring Parameters for OPC UA Client

OPC UA client maintains sessions in response to each execution of
the UaConnect function block. One execution of the UaConnect
function block contains that one corresponding session will be
created by the OPC UA client on the controller and correspondingly
one session will be created on the target OPC UA server.

ATTENTION: Make sure that the OPC UA client’s time is
synchronized to the controller’s time.

To configure an OPC UA client:

1. Click Configure Protocols > OPC UA Client. The OPC UA Client page
appears.

2. Select the values for the Max Session Count and Max Subscription
Per Session parameters.
See the following table for the parameter description.

Parameter Description

Max Session
Count

The maximum number of concurrent sessions
allowed by the client.

If you enter a value of 0, the number of
sessions allowed is unlimited.

The default value is 100.

Max
Subscriptions Per
Session

The maximum number of subscriptions
allowed by the client for one session.

If you enter a value of 0, the number of
subscriptions allowed is unlimited.

Table 8-2: OPC UA Client parameter description

3. Click Save.

Importing OPC UA Library
To import OPC UA Library
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1. In IEC Programming Workspace, from the project tree window, right-
click Libraries and select Insert> Firmware Library.

The Include library dialog appears.

2. Open OPCUA folder and select opcua.fwl, then click Include.

The OPCUA library is displayed under Libraries.

Importing Data Types of HonUaFbHelperTypes
To import Data Types of HonUaFbHelperTypes

1. In IEC Programming Workspace, from the project tree window, select
Data Types, click File> Import.

The Import / Export dialog appears.

2. Select Extended IEC 61131-3 Import, and click OK.

The Object types dialog appears.

3. Select Datatypesand click OK.

The Extended IEC 61131-3 dialog appears.

4. Browse to \Users\Public\Documents\ControlEdge
Builder\Libraries\OPCUAFBHelpers”, and select the target data
type. Click OK.

The HonUaFbHelperTypes is displayed under Data Types.

Importing an OPC UA POU

1. InIEC Programming Workspace, from the project tree window, select
Logical POUs, and click File> Import.

The Import / Export dialog appears.

2. Select Extended IEC 61131-3 Import, and click OK.

The Object types dialog appears.

3. Select POUand click OK.

The Extended IEC 61131-3 dialog appears.

4. Browse to \Users\Public\Documents\ControlEdge
Builder\Libraries\OPCUAFBHelpers”, and select the target POU.
Click OK.

The HonUaFbHelpers is displayed under Logic POUs.
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Configuring an OPC UA Logic
ControlEdge PLC OPC UA Client supports data value read and write
through below logic sequence.

Make sure that the OPC UA Server's time is synchronized to the Client
(the controller's) time.

To configure an OPC UA Logic

1. Establish the connection between OPC UA Client and OPC UA
Server;

2. Get the namespace index of OPC UA Server once the connection is
successfully established;

3. Get the Node handle;
4. Read the value of or write a value to a variable. The following

diagram presents the data access workflow:

Example logic for reading list of variables fromOPC UA Server

Two main function blocks with some auxiliary logics are used for this
application.
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1. HonUaConnectSecurityNone – Used for all read/write
applications, to establish the connection with OPC UA server or
disconnect an existing connection.

l ServerEndpointURL and sessionName need to be configured

l Parameter “Disconnect” used to disconnect an existing
connection, as there has a auxiliary function block to monitor
the status of the connection and handle error scenarions(Enable
=1): If no connection is detected (ConnectionHandle=0), this FB
2 will trigger the execution of FB “Ua…” to reestablish the
connection.

Only in two scenarios the value of “ConnectionHandle” will be 0,
after power on or disconnect the connection manually, so if user
want to disconnect the connection, normally procedure is disable
this HonUaHandleDetector first and then do disconnect operation.

2. HonUaReadNodeList

l DisableReadList – When set TRUE, disables this read block.
Read service will not be called with each task cycle.

l EnableReadList – When set TRUE, enables this read block. Read
service will be called with each task cycle. Output of
HonUaReadNodeLIst connects to this parameter and the rise
edge of this parameter will trigger the execution of
HonUaConnectSecurityNone.

l NodeIdCount – The number of Node IDs in NodeIdWriteList.
Define how many variable are expected to be read from OPC UA
Server.

l NodeIdReadList – Node identifiers of the nodes whose values
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are to be read by this block (max 20 identifiers).Structure type,
consists of three elements

IdentifierType – Array, to define the identifier type of the
variables expected to be read from Server, we can get detail
information of the variable in Server side, normally it is string
type (Initial value =1);

Identifier – Array, The variable name

Namespace – Array, define namespace for each variable, we can
get detail information of the variable in Server side or we can use
“GetNameSpace”.

OPC UA Error Code Reference
See the following table for OPC UA function block error codes
definition:

Error Code Symbolic ID Description

16#00000000 success NA

16#00000001 FB_GEN_ERR_INPUT_PARA_INVALID The input parameter is
invalid.

16#00000002 FB_GEN_ERR_RCV_RSP_TIME_OUT Time out and no
response data is
received.

16#00000003 FB_GEN_ERR_INTERNAL_TIME_OUT IPC is time out.

16#00000004 FB_GEN_ERR_INVALID_REQUEST The request is invalid.

0x00000000 OpcUa_Good The operation was
successful.

0x80000000 OpcUa_Bad The operation was
unsuccessful but no
specific reason is
known.

0x80010000 OpcUa_BadUnexpectedError An unexpected error
occurred.

0x80020000 OpcUa_BadInternalError An internal error
occurred as a result of
a programming or
configuration error.
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Error Code Symbolic ID Description

0x80030000 OpcUa_BadOutOfMemory Not enough memory
to complete the
operation.

0x80040000 OpcUa_BadResourceUnavailable An operating system
resource is not
available.

0x80050000 OpcUa_BadCommunicationError A low level
communication error
occurred.

0x80060000 OpcUa_BadEncodingError Encoding halted
because of invalid data
in the objects being
serialized.

0x80070000 OpcUa_BadDecodingError Decoding halted
because of invalid data
in the stream.

0x80080000 OpcUa_BadEncodingLimitsExceeded The message
encoding/decoding
limits imposed by the
stack have been
exceeded.

0x80B80000 OpcUa_BadRequestTooLarge The request message
size exceeds limits set
by the server.

0x80B90000 OpcUa_BadResponseTooLarge The response message
size exceeds limits set
by the client.

0x80090000 OpcUa_BadUnknownResponse An unrecognized
response was received
from the server.

0x800A0000 OpcUa_BadTimeout The operation timed
out.

0x800B0000 OpcUa_BadServiceUnsupported The server does not
support the requested
service.

0x800C0000 OpcUa_BadShutdown The operation was
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Error Code Symbolic ID Description

cancelled because the
application is shutting
down.

0x800D0000 OpcUa_BadServerNotConnected The operation could
not complete because
the client is not
connected to the
server.

0x800E0000 OpcUa_BadServerHalted The server has stopped
and cannot process
any requests.

0x800F0000 OpcUa_BadNothingToDo There was nothing to
do because the client
passed a list of
operations with no
elements.

0x80100000 OpcUa_BadTooManyOperations The request could not
be processed because
it specified too many
operations.

0x80DB0000 OpcUa_BadTooManyMonitoredItems The request could not
be processed because
there are too many
monitored items in the
subscription.

0x80110000 OpcUa_BadDataTypeIdUnknown The extension object
cannot be
(de)serialized because
the data type id is not
recognized.

0x80120000 OpcUa_BadCertificateInvalid The certificate
provided as a
parameter is not valid.

0x80130000 OpcUa_BadSecurityChecksFailed An error occurred
verifying security.

0x80140000 OpcUa_BadCertificateTimeInvalid The Certificate has
expired or is not yet
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Error Code Symbolic ID Description

valid.

0x80150000 OpcUa_BadCertificateIssuerTimeInvalid An Issuer Certificate
has expired or is not
yet valid.

0x80160000 OpcUa_BadCertificateHostNameInvalid The HostName used to
connect to a Server
does not match a
HostName in the
Certificate.

d 0x80170000 OpcUa_BadCertificateUriInvali The URI specified in
the
ApplicationDescription
does not match the
URI in the Certificate.

0x80180000 OpcUa_BadCertificateUseNotAllowed The Certificate may not
be used for the
requested operation.

0x80190000 OpcUa_BadCertificateIssuerUseNotAllowed The Issuer Certificate
may not be used for
the requested
operation.

0x801A0000 OpcUa_BadCertificateUntrusted The Certificate is not
trusted.

0x801B0000 OpcUa_BadCertificateRevocationUnknown It was not possible to
determine if the
Certificate has been
revoked.

0x801C0000 OpcUa_
BadCertificateIssuerRevocationUnknown

It was not possible to
determine if the Issuer
Certificate has been
revoked.

0x801D0000 OpcUa_BadCertificateRevoked The Certificate has
been revoked.

0x801E0000 OpcUa_BadCertificateIssuerRevoked The Issuer Certificate
has been revoked.

0x801F0000 OpcUa_BadUserAccessDenied User does not have
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Error Code Symbolic ID Description

permission to perform
the requested
operation.

0x80200000 OpcUa_BadIdentityTokenInvalid The user identity token
is not valid.

0x80210000 OpcUa_BadIdentityTokenRejected The user identity token
is valid but the server
has rejected it.

0x80220000 OpcUa_BadSecureChannelIdInvalid The specified secure
channel is no longer
valid.

0x80230000 OpcUa_BadInvalidTimestamp The timestamp is
outside the range
allowed by the server.

0x80240000 OpcUa_BadNonceInvalid The nonce does
appear to be not a
random value or it is
not the correct length.

0x80250000 OpcUa_BadSessionIdInvalid The session id is not
valid.

0x80260000 OpcUa_BadSessionClosed The session was closed
by the client.

0x80270000 OpcUa_BadSessionNotActivated The session cannot be
used because
ActivateSession has
not been called.

0x80280000 OpcUa_BadSubscriptionIdInvalid The subscription id is
not valid.

0x802A0000 OpcUa_BadRequestHeaderInvalid The header for the
request is missing or
invalid.

0x802B0000 OpcUa_BadTimestampsToReturnInvalid The timestamps to
return parameter is
invalid.

0x802C0000 OpcUa_BadRequestCancelledByClient The request was
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cancelled by the client.

0x002D0000 OpcUa_GoodSubscriptionTransferred The subscription was
transferred to another
session

0x002E0000 OpcUa_GoodCompletesAsynchronously The processing will
complete
asynchronously.

0x002F0000 OpcUa_GoodOverload Sampling has slowed
down due to resource
limitations.

0x00300000 OpcUa_GoodClamped The value written was
accepted but was
clamped

0x80310000 OpcUa_BadNoCommunication Communication with
the data source is d,
but not established,
and there is no last
known value available.

0x80320000 OpcUa_BadWaitingForInitialData Waiting for the server
to obtain values from
the underlying data
source.

0x80330000 OpcUa_BadNodeIdInvalid The syntax of the node
id is not valid.

0x80340000 OpcUa_BadNodeIdUnknown The node id refers to a
node that does not
exist in the server
address space.

0x80350000 OpcUa_BadAttributeIdInvalid The attribute is not
supported for the
specified Node.

0x80360000 OpcUa_BadIndexRangeInvalid The syntax of the index
range parameter is
invalid.

0x80370000 OpcUa_BadIndexRangeNoData No data exists within
the range of indexes
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Error Code Symbolic ID Description

specified.

0x80380000 OpcUa_BadDataEncodingInvalid The data encoding is
invalid.

0x80390000 OpcUa_BadDataEncodingUnsupported The server does not
support the requested
data encoding for the
node.

0x803A0000 OpcUa_BadNotReadable The access level does
not allow reading or
subscribing to the
Node.

0x803B0000 OpcUa_BadNotWritable The access level does
not allow writing to the
Node.

0x803C0000 OpcUa_BadOutOfRange The value was out of
range.

0x803D0000 OpcUa_BadNotSupported The requested
operation is not
supported.

0x803E0000 OpcUa_BadNotFound A requested item was
not found or a search
operation ended
without success.

0x803F0000 OpcUa_BadObjectDeleted The object cannot be
used because it has
been deleted.

0x80400000 OpcUa_BadNotImplemented Requested operation is
not implemented.

0x80410000 OpcUa_BadMonitoringModeInvalid The monitoring mode
is invalid.

0x80420000 OpcUa_BadMonitoredItemIdInvalid The monitoring item id
does not refer to a
valid monitored item.

0x80430000 OpcUa_BadMonitoredItemFilterInvalid The monitored item
filter parameter is not
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valid.

0x80440000 OpcUa_BadMonitoredItemFilterUnsupported The server does not
support the requested
monitored item filter.

0x80450000 OpcUa_BadFilterNotAllowed A monitoring filter
cannot be used in
combination with the
attribute specified.

0x80460000 OpcUa_BadStructureMissing A mandatory
structured parameter
was missing or null.

0x80470000 OpcUa_BadEventFilterInvalid The event filter is not
valid.

0x80480000 OpcUa_BadContentFilterInvalid The content filter is
not valid.

0x80C10000 OpcUa_BadFilterOperatorInvalid An unregognized
operator was provided
in a filter.

0x80C20000 OpcUa_BadFilterOperatorUnsupported A valid operator was
provided, but the
server does not
provide support for
this filter operator.

0x80C30000 OpcUa_BadFilterOperandCountMismatch The number of
operands provided for
the filter operator was
less then expected for
the operand provided.

0x80490000 OpcUa_BadFilterOperandInvalid The operand used in a
content filter is not
valid.

0x80C40000 OpcUa_BadFilterElementInvalid The referenced
element is not a valid
element in the content
filter.

0x80C50000 OpcUa_BadFilterLiteralInvalid The referenced literal
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Error Code Symbolic ID Description

is not a valid value.

0x804A0000 OpcUa_BadContinuationPointInvalid The continuation point
provide is longer valid.

0x804B0000 OpcUa_BadNoContinuationPoints The operation could
not be processed
because all
continuation points
have been allocated.

0x804C0000 OpcUa_BadReferenceTypeIdInvalid The operation could
not be processed
because all
continuation points
have been allocated.

0x804D0000 OpcUa_BadBrowseDirectionInvalid The browse direction is
not valid.

0x804E0000 OpcUa_BadNodeNotInView The node is not part of
the view.

0x804F0000 OpcUa_BadServerUriInvalid The ServerUri is not a
valid URI.

0x80500000 OpcUa_BadServerNameMissing No ServerName was
specified.

0x80510000 OpcUa_BadDiscoveryUrlMissing No DiscoveryUrl was
specified.

0x80520000 OpcUa_BadSempahoreFileMissing The semaphore file
specified by the client
is not valid.

0x80530000 OpcUa_BadRequestTypeInvalid The security token
request type is not
valid.

0x80540000 OpcUa_BadSecurityModeRejected The security mode
does not meet the
requirements set by
the Server.

0x80550000 OpcUa_BadSecurityPolicyRejected The security policy
does not meet the
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requirements set by
the Server.

0x80560000 OpcUa_BadTooManySessions The maximum number
of sessions has been
reached.

0x80570000 OpcUa_BadUserSignatureInvalid The user token
signature is missing or
invalid.

0x80580000 OpcUa_BadApplicationSignatureInvalid The signature
generated with the
client certificate is
missing or invalid.

0x80590000 OpcUa_BadNoValidCertificates The client did not
provide at least one
software certificate
that is valid and meets
the profile
requirements for the
server.

0x80C60000 OpcUa_BadIdentityChangeNotSupported The Server does not
support changing the
user identity assigned
to the session.

0x805A0000 OpcUa_BadRequestCancelledByRequest The request was
cancelled by the client
with the Cancel
service.

0x805B0000 OpcUa_BadParentNodeIdInvalid The parent node id
does not to refer to a
valid node.

0x805C0000 OpcUa_BadReferenceNotAllowed The reference could
not be created
because it violates
constraints imposed
by the data model.

0x805D0000 OpcUa_BadNodeIdRejected The requested node id
was reject because it
was either invalid or
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server does not allow
node ids to be
specified by the client.

0x805E0000 OpcUa_BadNodeIdExists The requested node id
is already used by
another node.

0x805F0000 OpcUa_BadNodeClassInvalid The node class is not
valid.

0x80600000 OpcUa_BadBrowseNameInvalid The browse name is
invalid.

0x80610000 OpcUa_BadBrowseNameDuplicated The browse name is
not unique among
nodes that share the
same relationship with
the parent.

0x80620000 OpcUa_BadNodeAttributesInvalid The node attributes are
not valid for the node
class.

0x80630000 OpcUa_BadTypeDefinitionInvalid The type definition
node id does not
reference an
appropriate type node.

0x80640000 OpcUa_BadSourceNodeIdInvalid The source node id
does not reference a
valid node.

0x80650000 OpcUa_BadTargetNodeIdInvalid The target node id
does not reference a
valid node.

0x80660000 OpcUa_BadDuplicateReferenceNotAllowed The reference type
between the nodes is
already d.

0x80670000 OpcUa_BadInvalidSelfReference The server does not
allow this type of self
reference on this node.

0x80680000 OpcUa_BadReferenceLocalOnly The reference type is
not valid for a
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reference to a remote
server.

0x80690000 OpcUa_BadNoDeleteRights The server will not
allow the node to be
deleted.

0x40BC0000 OpcUa_UncertainReferenceNotDeleted The server was not able
to delete all target
references.

0x806A0000 OpcUa_BadServerIndexInvalid The server index is not
valid.

0x806B0000 OpcUa_BadViewIdUnknown The view id does not
refer to a valid view
node.

0x80C90000 OpcUa_BadViewTimestampInvalid The view timestamp is
not available or not
supported.

0x80CA0000 OpcUa_BadViewParameterMismatch The view parameters
are not consistent with
each other.

0x80CB0000 OpcUa_BadViewVersionInvalid The view version is not
available or not
supported.

0x40C00000 OpcUa_UncertainNotAllNodesAvailable The list of references
may not be complete
because the
underlying system is
not available.

0x00BA0000 OpcUa_GoodResultsMayBeIncomplete The server should have
followed a reference to
a node in a remote
server but did not. The
result set may be
incomplete.

0x80C80000 OpcUa_BadNotTypeDefinition The provided Nodeid
was not a type
definition nodeid.
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0x406C0000 OpcUa_UncertainReferenceOutOfServer One of the references
to follow in the relative
path references to a
node in the address
space in another
server.

0x806D0000 OpcUa_BadTooManyMatches The requested
operation has too
many matches to
return.

0x806E0000 OpcUa_BadQueryTooComplex The requested
operation requires too
many resources in the
server.

0x806F0000 OpcUa_BadNoMatch The requested
operation has no
match to return.

0x80700000 OpcUa_BadMaxAgeInvalid The max age
parameter is invalid.

0x80710000 OpcUa_BadHistoryOperationInvalid The history details
parameter is not valid.

0x80720000 OpcUa_BadHistoryOperationUnsupported The server does not
support the requested
operation.

0x80BD0000 OpcUa_BadInvalidTimestampArgument The d timestamp to
return was invalid.

0x80730000 OpcUa_BadWriteNotSupported The server not does
support writing the
combination of value,
status and timestamps
provided.

0x80740000 OpcUa_BadTypeMismatch The value supplied for
the attribute is not of
the same type as the
attribute's value.

0x80750000 OpcUa_BadMethodInvalid The method id does
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not refer to a method
for the specified
object.

0x80760000 OpcUa_BadArgumentsMissing The client did not
specify all of the input
arguments for the
method.

0x80770000 OpcUa_BadTooManySubscriptions The server has reached
its maximum number
of subscriptions.

0x80780000 OpcUa_BadTooManyPublishRequests The server has reached
the maximum number
of queued publish
requests.

0x80790000 OpcUa_BadNoSubscription There is no
subscription available
for this session.

0x807A0000 OpcUa_BadSequenceNumberUnknown The sequence number
is unknown to the
server.

0x807B0000 OpcUa_BadMessageNotAvailable The requested
notification message is
no longer available.

0x807C0000 OpcUa_BadInsufficientClientProfile The Client of the
current Session does
not support one or
more Profiles that are
necessary for the
Subscription.

0x80BF0000 OpcUa_BadStateNotActive The sub-state machine
is not currently active.

0x807D0000 OpcUa_BadTcpServerTooBusy The server cannot
process the request
because it is too busy.

0x807E0000 OpcUa_BadTcpMessageTypeInvalid The type of the
message specified in
the header invalid.
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0x807F0000 OpcUa_BadTcpSecureChannelUnknown The SecureChannelId
and/or TokenId are not
currently in use.

0x80800000 OpcUa_BadTcpMessageTooLarge The size of the
message specified in
the header is too large.

0x80810000 OpcUa_BadTcpNotEnoughResources There are not enough
resources to process
the request.

0x80820000 OpcUa_BadTcpInternalError An internal error
occurred.

0x80830000 OpcUa_BadTcpEndpointUrlInvalid The Server does not
recognize the
QueryString specified.

0x80840000 OpcUa_BadRequestInterrupted The request could not
be sent because of a
network interruption.

0x80850000 OpcUa_BadRequestTimeout Timeout occurred
while processing the
request.

0x80860000 OpcUa_BadSecureChannelClosed The secure channel
has been closed.

0x80870000 OpcUa_BadSecureChannelTokenUnknown The token has expired
or is not recognized.

0x80880000 OpcUa_BadSequenceNumberInvalid The sequence number
is not valid.

0x80BE0000 OpcUa_BadProtocolVersionUnsupported The applications do
not have compatible
protocol versions.

0x80890000 OpcUa_BadConfigurationError There is a problem with
the configuration that
affects the usefulness
of the value.

0x808A0000 OpcUa_BadNotConnected The variable should
receive its value from
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another variable, but
has never been
configured to do so.

0x808B0000 OpcUa_BadDeviceFailure There has been a
failure in the
device/data source
that generates the
value that has affected
the value.

0x808C0000 OpcUa_BadSensorFailure There has been a
failure in the sensor
from which the value is
derived by the
device/data source.

0x808D0000 OpcUa_BadOutOfService The source of the data
is not operational.

0x808E0000 OpcUa_BadDeadbandFilterInvalid The deadband filter is
not valid.

0x408F0000 OpcUa_
UncertainNoCommunicationLastUsableValue

Communication to the
data source has failed.
The variable value is
the last value that had
a good quality.

0x40900000 OpcUa_UncertainLastUsableValue Whatever was updating
this value has stopped
doing so.

0x40910000 OpcUa_UncertainSubstituteValue The value is an
operational value that
was manually
overwritten.

0x40920000 OpcUa_UncertainInitialValue The value is an initial
value for a variable
that normally receives
its value from another
variable.

0x40930000 OpcUa_UncertainSensorNotAccurate The value is at one of
the sensor limits.
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0x40940000 OpcUa_UncertainEngineeringUnitsExceeded The value is outside of
the range of values d
for this parameter.

0x40950000 OpcUa_UncertainSubNormal The value is derived
from multiple sources
and has less than the
required number of
Good sources.

0x00960000 OpcUa_GoodLocalOverride The value has been
overridden.

0x80970000 OpcUa_BadRefreshInProgress This Condition refresh
failed, a Condition
refresh operation is
already in progress.

0x80980000 OpcUa_BadConditionAlreadyDisabled This condition has
already been disabled.

0x80CC0000 OpcUa_BadConditionAlreadyEnabled This condition has
already been enabled.

0x80990000 OpcUa_BadConditionDisabled Property not available,
this condition is
disabled.

0x809A0000 OpcUa_BadEventIdUnknown The specified event id
is not recognized.

0x80BB0000 OpcUa_BadEventNotAcknowledgeable The event cannot be
acknowledged.

0x80CD0000 OpcUa_BadDialogNotActive The dialog condition is
not active.

0x80CE0000 OpcUa_BadDialogResponseInvalid The response is not
valid for the dialog.

0x80CF0000 OpcUa_BadConditionBranchAlreadyAcked The condition branch
has already been
acknowledged.

0x80D00000 OpcUa_
BadConditionBranchAlreadyConfirmed

The condition branch
has already been
confirmed.
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0x80D10000 OpcUa_BadConditionAlreadyShelved The condition has
already been shelved.

0x80D20000 OpcUa_BadConditionNotShelved The condition is not
currently shelved.

0x80D30000 OpcUa_BadShelvingTimeOutOfRange The shelving time not
within an acceptable
range.

0x809B0000 OpcUa_BadNoData No data exists for the
requested time range
or event filter.

0x80D70000 OpcUa_BadBoundNotFound No data found to
provide upper or lower
bound value.

0x80D80000 OpcUa_BadBoundNotSupported The server cannot
retrieve a bound for
the variable.

0x809D0000 OpcUa_BadDataLost Data is missing due to
collection
started/stopped/lost.

0x809E0000 OpcUa_BadDataUnavailable Expected data is
unavailable for the
requested time range
due to an un-mounted
volume, an off-line
archive or tape, or
similar reason for
temporary
unavailability.

0x809F0000 OpcUa_BadEntryExists The data or event was
not successfully
inserted because a
matching entry exists.

0x80A00000 OpcUa_BadNoEntryExists The data or event was
not successfully
updated because no
matching entry exists.

0x80A10000 OpcUa_BadTimestampNotSupported The client requested
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Error Code Symbolic ID Description

history using a
timestamp format the
server does not
support (i.e requested
ServerTimestamp when
server only supports
SourceTimestamp).

0x00A20000 OpcUa_GoodEntryInserted The data or event was
successfully inserted
into the historical
database.

0x00A30000 OpcUa_GoodEntryReplaced The data or event field
was successfully
replaced in the
historical database.

0x40A40000 OpcUa_UncertainDataSubNormal The value is derived
from multiple values
and has less than the
required number of
Good values.

0x00A50000 OpcUa_GoodNoData No data exists for the
requested time range
or event filter.

0x00A60000 OpcUa_GoodMoreData The data or event field
was successfully
replaced in the
historical database.

0x80D40000 OpcUa_BadAggregateListMismatch The requested number
of Aggregates does
not match the
requested number of
NodeIds.

0x80D50000 OpcUa_BadAggregateNotSupported The requested
Aggregate is not
support by the server.

0x80D60000 OpcUa_BadAggregateInvalidInputs The aggregate value
could not be derived
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due to invalid data
inputs.

0x80DA0000 OpcUa_BadAggregateConfigurationRejected The aggregate
configuration is not
valid for specified
node.

0x00D90000 OpcUa_GoodDataIgnored The request pecifies
fields which are not
valid for the EventType
or cannot be saved by
the historian.

0x00A70000 OpcUa_GoodCommunicationEvent The communication
layer has raised an
event.

0x00A80000 OpcUa_GoodShutdownEvent The system is shutting
down.

0x00A90000 OpcUa_GoodCallAgain The operation is not
finished and needs to
be called again.

0x00AA0000 OpcUa_GoodNonCriticalTimeout A non-critical timeout
occurred.

0x80AB0000 OpcUa_BadInvalidArgument One or more
arguments are invalid.

0x80AC0000 OpcUa_BadConnectionRejected Could not establish a
network connection to
remote server.

0x80AD0000 OpcUa_BadDisconnect The server has
disconnected from the
client.

0x80AE0000 OpcUa_BadConnectionClosed The network
connection has been
closed.

0x80AF0000 OpcUa_BadInvalidState The operation cannot
be completed because
the object is closed,
uninitialized or in
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Error Code Symbolic ID Description

some other invalid
state.

0x80B00000 OpcUa_BadEndOfStream Cannot move beyond
end of the stream.

0x80B10000 OpcUa_BadNoDataAvailable No data is currently
available for reading
from a non-blocking
stream.

0x80B20000 OpcUa_BadWaitingForResponse The asynchronous
operation is waiting for
a response.

0x80B30000 OpcUa_BadOperationAbandoned The asynchronous
operation was
abandoned by the
caller.

0x80B40000 OpcUa_BadExpectedStreamToBlock The stream did not
return all data
requested (possibly
because it is a non-
blocking stream).

0x80B50000 OpcUa_BadWouldBlock Non blocking
behaviour is required
and the operation
would block.

0x80B60000 OpcUa_BadSyntaxError A value had an invalid
syntax.

0x81000000 OpcUa_StartOfStackStatusCodes Begin of status codes
internal to the stack.

0x81010000 OpcUa_BadSignatureInvalid The message signature
is invalid.

0x81040000 OpcUa_BadExtensibleParameterInvalid The extensible
parameter provided is
not a valid for the
service.

0x81050000 OpcUa_
BadExtensibleParameterUnsupported

The extensible
parameter provided is
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valid but the server
does not support it.

0x81060000 OpcUa_BadHostUnknown The hostname could
not be resolved.

0x81070000 OpcUa_BadTooManyPosts Too many posts were
made to a semaphore.

0x81080000 OpcUa_BadSecurityConfig The security
configuration is not
valid.

0x81090000 OpcUa_BadFileNotFound Invalid file name
specified.

0x810A0000 OpcUa_BadContinue Accept bad result and
continue anyway.

0x810B0000 OpcUa_BadHttpMethodNotAllowed Accept bad result and
continue anyway.

0x810C0000 OpcUa_BadFileExists File exists.
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CHAPTER

9 CONFIGURING CDA

CDA is short for Control Data Access. CDA protocol supports peer to
peer communication between ControlEdge 900 controller with C300
controller or ACE or SIM-300 or SIM-ACE. ControlEdge 900
controller acts as the CDA responder and C300 controller (or the
others mentioned above) acts as the CDA initiator.

It supports:

n Maximum 20 CDA initiators connected to a single ControlEdge
900 CPM

n Maximum 1000 PPS (parameters per second) between CDA
initiators and ControlEdge 900 CPM

n Both read and write access from C300 or ACE Controller

n Read access from SIM-300 or SIM-ACE

n Communication Security including IPsec and embedded Firewall

To configure a CDA responder, perform the following steps:

In this section:

Installing ControlEdge integration service 148

Configuring a CDA Responder 149

Publishing to Experion 151

Publishing when ControlEdge Builder is launched from
Configuration Studio 151

Publishing when ControlEdge Builder is launched separately
on an Experion node 151

Publishing when ControlEdge Builder is launched on non-
Experion node 152
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Installing ControlEdge integration service
Starting with Experion R501.1, you can communicate with the
following controllers in the Experion PKS system through CDA. You
should install and start the ControlEdge integration service on the
Experion Server.

n C300

n ACE

n Sim-C300

n Sim-ACE

ATTENTION: It is required to install the ControlEdge integration
service on both Experion servers when using Experion Server
redundancy, and all Server nodes in the Experion Backup
Conotrol Center topology.

To install the ControlEdge integration service

1. Insert the ControlEdge Builder Media Kit into the DVD-ROM drive.

2. Browse to the folder ControlEdgeIntegrationService, and double-
click the file ControlEdgeIntegrationService.exe.

3. The ControlEdgeIntegrationService - InstallShied Wizard dialog
appears. Click Next.

4. In the License Agreement page, click I accept the terms in the license
agreement and click Next.

5. In the Customer Information page, enter your information if
required. Click Next.

6. In the Setup Type page, select the setup type that best suits your
needs. It is recommended to select Complete. Click Next.

7. In the Ready to Install the Program page, click Install to begin the
installation. You can click Cancel to abort the installation.

8. The installation is in progress, and then the Set Service Login dialog
appears.

9. Enter the Username, Password and Confirm password for the user
account that the ControlEdge Integration Service shall log on as.
Click OK.
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ATTENTION: The user name must be started with ".\". The
user should have a "Security level" of at least "Engineer" in
the Experion server. See "Configuring system security" in the
Experion Server and Client Configuration Guide for more
information.

10. The InstallShield Wizard Completed dialog appears, click Finish.

To check the status of the ControlEdge integration service

1. Click Start button of PC, and enter services.msc in the search bar.
The Services dialog appears.

2. Find Honeywell ControlEdge Integration Service, check the Status is
Running. If it is not, right-click the service and click Start.

3. Check the Startup Type is Automatic. If it is not, right-click the
service and select Properties, and then select Automatic from the
Startup type drop-down list.

Configuring a CDA Responder
A new project is created and a controller is added to the project in
ControlEdge Builder. See "Creating a project" and "Connecting a
controller" in ControlEdge Builder User's Guide for more details.

To set a controller as a CDA responder

1. From the Home Page, click Configure Ethernet Ports and select
ETH1 or ETH2.

2. Under Network Setting, select Use the following IP address and enter
the details in the IP Address, Subnet Mask and Gateway fields.

TIP: The IP addresses for the controller and Experion
devices to be communicated must be on the same subnet.

3. Under Protocol Binding, select CDA Responder to bind CDA
responder to the Ethernet port.

4. Click Save to save the configuration, and click Back to return to the
Home Page.

5. Select CDA from the global variables or local variables you want to
publish to Experion.
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See the following table for the data type matching between the
ControlEdge 900 controller variables and Experion Server
parameters.

Data type in ControlEdge 900
controller

Data type in Experion

IEC_BOOL BOOLEAN

IEC_SINT INT8

IEC_INT INT16

IEC_DINT INT32

IEC_USINT UINIT8

IEC_UINT UINT16

IEC_UDINT UINT32

IEC_REAL FLOAT32

IEC_LREAL FLOAT64

IEC_BYTE UINT8

IEC_WORD UINT16

IEC_DWORD UINT32

IEC_ULINT UINT64

IEC_LWORD UINT64

IEC_STRING STRING

IEC_STRUCT See Note 1 below.

Note 1: Structure is a data type of I/O variable, so you should
create a single variable for each parameter in the structure for
CDA communication.

a. Click IEC Programming Workspace from the toolbar.

b. Perform either of the following methods to select CDA.

l From the variable sheets, select CDA.
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l From the variable properties dialog, select CDA.

6. Click Make to compile the configuration to the controller.

Publishing to Experion
For peer to peer connection to C300 or other Experion CEE based
controller, you need to publish the configuration to the Experion
Server through CDA.

Publishing when ControlEdge Builder is launched
from Configuration Studio
In this scenario, ControlEdge Builder is launched from Configuration
Studio > Control Strategy > ControlEdge Integration > Configure control
strategy, the ControlEdge Builder is already running under the user
credentials supplied from Configuration Studio.

From the Home Page, click Publish to Experion under Programming and
I/O. The project configuration will be published to Experion directly.

Publishing when ControlEdge Builder is launched
separately on an Experion node
In this scenario the Experion client components are available on the
node, but the context for establishing the connection to the Server
and the user credentials are not available from Configuration Studio.

Prerequisites

ControlEdge Builder is launched separately on an Experion node, not
from Configuration Studio.
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1. From the Home Page, click Publish to Experion under Programming
and I/O.

2. Enter Experion server, Domain, User name and Password.
See the following table for the parameter description.

Parameter Description

Experion
server

The base part of the Experion server name you would
like to connect to. For example if you have redundant
Experion Servers, enter the hostname of the server
without the last “A” or “B” letter.

Use
current
Windows
account

Connect with current Windows account. If you select
this checkbox, you do not need to enter Domain, User
name or Password.

Domain Domain name.

If you enter ".", it means current application domain.

User
name

User account name

Password Password for the user account, which is case-
sensitive.

3. Click Publish. A message appears indicating that the configuration
is published successfully. Click OK.

Publishing when ControlEdge Builder is launched on
non-Experion node
The “Experion client components” optional installation package must
be installed from the Experion Installation Media which you want to
communicate with for the Publish to Experion function to work. These
can be installed through the “Optional Components” selection on the
installation media. If these components are not installed, a message
appears indicating “Unable to publish to Experion as client
components are not installed”, but all other ControlEdge Builder
functions should continue to work as expected.

Prerequisites

n The "Experion client components" are installed on the
ControlEdge Builder node.
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n ControlEdge Builder is installed on a same version of Microsoft
Windows that is supported for either Experion Client or Server that
you want to communicate with. Refer to the Experion
specifications for the specific release for supported operation
system details.

n ControlEdge Builder is launched.

1. From the Home Page, click Publish to Experion under Programming
and I/O.

2. Enter Experion server, Domain, User name and Password.
See the following table for the parameter description.

Parameter Description

Experion
server

The base part of the Experion server name you would
like to connect to. For example if you have redundant
Experion Servers, enter the hostname of the server
without the last “A” or “B” letter.

Use
current
Windows
account

Connect with current Windows account. If you select
this checkbox, you do not need to enter Domain, User
name or Password.

Domain Domain name.

If you enter ".", it means current application domain.

User
name

User account name

Password Password for the user account, which is case-
sensitive.

3. Click Publish. A message appears indicating that the configuration
is published successfully. Click OK.
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CHAPTER

10 USER DEFINED PROTOCOL
See the following rules for using user defined protocol:

n User defined protocol can be bound on RS232 and RS485 ports.
For each serial port, it allowed to connect one device via user
defined protocol.

n Two function blocks are provided: COM_SEND and COM_RECV.
n Another function block CRC_16 can be used to handle CRC.
n You can make data type and use function blocks under library
PROCONS to group or ungroup data frame.

Configuring User Defined Protocol
A new project is created and a controller is added to the project in
ControlEdge Builder. See "Creating a project" and "Connecting a
controller" in ControlEdge Builder User's Guide for more details.

To configure the User Defined Protocol:

For ControlEdge RTU:

1. From the Home Page, click Configure Serial Ports and select RS232-
1 , RS232-2, RS485-1 or RS485-2.

2. Under General, select the target options in all fields.

3. Under Protocol Binding, select User Defined to bind it to the serial
port.
When you select this option, the Delimiter Mode (Optional) panel
appears including three settings: Read-interval Timeout (ms), Max
Length (Bytes) and End Delimiter (Hex). You can configure them
optionally to validate if a data frame is sent completely.

l Read-interval Timeout (ms): The interval between the last data
packet sent and the first keepalive probe, ranging from 0 to
10000 (ms). If the interval between the arrivals of any two bytes
exceeds this Timeout, system regards it has already received a
complete data frame.
The default value is 0 which means this option is disabled.

l Max Length (Bytes): The maximum number of bytes for a data
frame, ranging from 0 to 1024. If the length of a received data
frame exceeds the Max Length, system regards it has already
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received a complete data frame.
The default value is 0 which means this option is disabled.

l End Delimiter (Hex): Configured special characters in
hexadecimal and based on bytes validates if a data frame is sent
completely. If the received data frame has same characters with
the End Delimiter, system regards it has already received a
complete data frame.
The default setting is blank which means this option is disabled.

4. Click Save to save the configuration, and click Back to return to the
Home Page.

5. Click Connect from the Home Page to connect a controller. For the
user name and password, see "User Privileges" in ControlEdge
Builder User's Guide.

6. Click Download from the Home Page to load the configuration of
User Defined protocol to the controller.

For ControlEdge PLC:

1. From the Home Page, under I/O and Communications, click
Configure Modules > Configure Serial Modules.

2. Click Add Serial Module, the Add Serial Module dialog appears.

3. Select the Type, assign the Rack and Slot for the module.

4. Click OK to add the serial module.

5. Select a serial module. There are four serial ports to be configured,
RS232-1, RS232-2, RS485-1 and RS485-2. Select the target port
and configure appropriate values for the parameters.

6. Under Protocol Binding, select User Defined from the Port Protocol
drop-down list.
See the above corresponding information of ControlEdge RTU for
Delimiter Mode (Optional). But for ControlEdge PLC, the maximum
number of Max Length (Bytes) bytes for a data frame, ranging from
0 to 532.

7. Click Save to save the configuration, and click Back to return to the
Home Page.

8. Click Connect from the Home Page to connect a controller. For the
user name and password, see "User Privileges" in ControlEdge
Builder User's Guide.
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9. Click Download from the Home Page to load the configuration of
User Defined protocol to the controller.

Creating a data type for User Defined Protocol
Before you begin to program the function blocks, you should create a
data type for the user defined protocol.

See the following table for reference of the frame structure:

No Message
Size
(Bytes)

Type Remarks

0 STX 1 HEX 0X02

1 ADDR 2 HEX Group ID, Tracker ID
(0X01~0xFF)

2 CMD 4 HEX SSF, BRO, CTG, ACK
(0X01~-xFF)

3 DATA 4 HEX Direction Mode Control,
Wind Speed[option], GPS
(HEX)

4 CRC16 2 HEX 0x??0x??

5 ETX 1 HEX 0x03

Sum 14

And refer to the following picture as an example:
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Configuring User Defined Protocol Function
Block

After downloading the configuration, you need to program the target
device for the project in IEC Programming Workspace.

To configure a User Defined Protocol function block:

1. From the IEC Programming Workspace, under the Project Tree
Window, right-click Logical POUs and select Insert > Program.

2. Enter the Name for the new POU, and select the desired
programming Language. For the following steps, FBD language is
used as an example.

3. Click OK to insert the new POU in the project tree.
4. Add a Task as follows:

a. Under Physical Hardware, right-click Task and select Insert >
Task.

b. Enter the Name and select the task type as CYCLIC, and click OK.
c. In the Task settings dialog, configure the corresponding

parameters.
d. Click OK.

5. Right-click the task you have inserted, and select Insert > Program
instance.

6. Enter a name in the Program instance field.
The program instance must not be named “RTU” or
“GlobalVariable”.

7. Select the program you want to associate from the Program type
drop-down list.

8. Right-click Libraries and select Insert > Firmware Library, select
UserDefined.fwl under UserDefined folder. Then click Include.

9. Under Logical POUs, double-click the code worksheet of the
program that you have inserted.

10. From the Edit Wizard, select UserDefined from the Group list. There
are two function blocks available for programming: CMD_RECV
and CMD_SEND.

11. Drag the target function block into the workplace to display the
function block.
For more information about the function block, right-click it and
select Help on FB/FU to display the embedded help.
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12. Create a data type for User Defined Protocol. See "Creating a data
type for User Defined Protocol" on page 157 for more
information.

13. Double-click the pin-outs of the function block to assign variables.

Assign Initial value and I/O address details.

14. Use function block under PROCONS to group or ungroup data
frame.
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You can click View-->Watch Window and add the corresponding
variables to monitor.
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15. Click OK.
16. Click Make from the toolbar to compile the programs.
17. Click Download from the toolbar to download the compiled

programs to the controller.
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NOTICES

Trademarks

Experion® is a registered trademark of Honeywell International, Inc.

ControlEdge™ is a trademark of Honeywell International, Inc.

OneWireless™ is a trademark of Honeywell International, Inc.

Other trademarks

Microsoft and SQL Server are either registered trademarks or
trademarks of Microsoft Corporation in the United States and/or
other countries.

Trademarks that appear in this document are used only to the benefit
of the trademark owner, with no intention of trademark infringement.

Third-party licenses

This product may contain or be derived from materials, including
software, of third parties. The third party materials may be subject to
licenses, notices, restrictions and obligations imposed by the licensor.
The licenses, notices, restrictions and obligations, if any, may be found
in the materials accompanying the product, in the documents or files
accompanying such third party materials, in a file named third_party_
licenses on the media containing the product, or at
http://www.honeywell.com/ps/thirdpartylicenses.

Documentation feedback

You can find the most up-to-date documents on the Honeywell
Process Solutions support website at:

http://www.honeywellprocess.com/support

If you have comments about Honeywell Process Solutions
documentation, send your feedback to:

hpsdocs@honeywell.com

Use this email address to provide feedback, or to report errors and
omissions in the documentation. For immediate help with a technical
problem, contact your local Honeywell Technical Assistance Center
(TAC).

162

Notices

http://www.honeywell.com/ps/thirdpartylicenses
http://www.honeywellprocess.com/support
mailto:hpsdocs@honeywell.com


163

How to report a security vulnerability

For the purpose of submission, a security vulnerability is defined as a
software defect or weakness that can be exploited to reduce the
operational or security capabilities of the software.

Honeywell investigates all reports of security vulnerabilities affecting
Honeywell products and services.

To report a potential security vulnerability against any Honeywell
product, please follow the instructions at:

https://honeywell.com/pages/vulnerabilityreporting.aspx

Submit the requested information to Honeywell using one of the
following methods:

n Send an email to security@honeywell.com.
or

n Contact your local Honeywell Technical Assistance Center (TAC)
listed in the “Support” section of this document.

Support

For support, contact your local Honeywell Process Solutions
Customer Contact Center (CCC). To find your local CCC visit the
website, https://www.honeywellprocess.com/en-US/contact-
us/customer-support-contacts/Pages/default.aspx.

Training classes

Honeywell holds technical training classes that are taught by process
control systems experts. For more information about these classes,
contact your Honeywell representative, or see
http://www.automationcollege.com.
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